Cognos Analytics

A Complete Guide

For Report Writers/Authors
## Contents

Notes.................................................................................................................................6
Preface..............................................................................................................................7
Introduction.........................................................................................................................7
  What Remains the Same .................................................................................................7
  What’s New and Different ..............................................................................................7
About the Warehouse ......................................................................................................8
The CeDAR Website .........................................................................................................9
Logging into Cognos Analytics ......................................................................................10
  Additional Ways to Enter the Information Warehouse ................................................10
User Experience ..............................................................................................................11
The Welcome Portal ........................................................................................................11
My Content, Team Content, Packages, and Folders ....................................................13
Recent Items ....................................................................................................................13
Search and Find Content .................................................................................................14
  Narrow Your Search with Filters ................................................................................14
  Save Your Search .........................................................................................................14
Navigation .......................................................................................................................15
  Welcome Menu (Page Switcher) . ...............................................................................15
  More/Set as Home .....................................................................................................15
  Home Button ............................................................................................................15
  Notifications .............................................................................................................16
  Personal Menu ..........................................................................................................16
Exploring Content ..........................................................................................................17
Viewing and Interacting with Content .........................................................................17
  The Action Menu ....................................................................................................19
Report Properties ..........................................................................................................19
Password Protecting PDF Documents ......................................................................20
Prompts ..........................................................................................................................21
Drill Through Reports ..................................................................................................22
Report Options ...............................................................................................................22
Subscriptions ..................................................................................................................22
  Subscribing to Reports ..............................................................................................22
  Notifications ..........................................................................................................23
<table>
<thead>
<tr>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Schedules</td>
<td>23</td>
</tr>
<tr>
<td>Managing Your Schedules and Subscriptions</td>
<td>24</td>
</tr>
<tr>
<td>Report Views</td>
<td>24</td>
</tr>
<tr>
<td>Editing Reports</td>
<td>24</td>
</tr>
<tr>
<td>Report Output Options</td>
<td>25</td>
</tr>
<tr>
<td>Interactivity Mode</td>
<td>25</td>
</tr>
<tr>
<td>Report Versions</td>
<td>26</td>
</tr>
<tr>
<td>Bursting Reports</td>
<td>26</td>
</tr>
<tr>
<td>Reporting in Cognos Analytics - Overview</td>
<td>30</td>
</tr>
<tr>
<td>Modifying Existing Reports</td>
<td>30</td>
</tr>
<tr>
<td>Report Function Mapping</td>
<td>31</td>
</tr>
<tr>
<td>Creating a Report</td>
<td>32</td>
</tr>
<tr>
<td>Templates and Themes</td>
<td>32</td>
</tr>
<tr>
<td>Choosing a Package</td>
<td>33</td>
</tr>
<tr>
<td>Reporting Interface</td>
<td>34</td>
</tr>
<tr>
<td>Insertable Objects Pane</td>
<td>35</td>
</tr>
<tr>
<td>The Toolbox</td>
<td>35</td>
</tr>
<tr>
<td>Report Tab Pages</td>
<td>36</td>
</tr>
<tr>
<td>Queries and Conditions</td>
<td>36</td>
</tr>
<tr>
<td>Report Specification</td>
<td>37</td>
</tr>
<tr>
<td>Exploring Page Views</td>
<td>37</td>
</tr>
<tr>
<td>Properties Pane</td>
<td>38</td>
</tr>
<tr>
<td>More Options</td>
<td>39</td>
</tr>
<tr>
<td>Turning Off this Functionality</td>
<td>39</td>
</tr>
<tr>
<td>On-Demand Toolbar</td>
<td>40</td>
</tr>
<tr>
<td>Turning Interactivity Mode On/Off</td>
<td>41</td>
</tr>
<tr>
<td>Creating and Modifying Reports</td>
<td>42</td>
</tr>
<tr>
<td>Creating a New Report in Cognos Analytics</td>
<td>42</td>
</tr>
<tr>
<td>Validating a Report</td>
<td>44</td>
</tr>
<tr>
<td>Running a Report</td>
<td>44</td>
</tr>
<tr>
<td>Saving Report Output</td>
<td>45</td>
</tr>
<tr>
<td>Saving a Report</td>
<td>45</td>
</tr>
<tr>
<td>Removing a Column</td>
<td>46</td>
</tr>
<tr>
<td>Source Tab VS Data Items Tab</td>
<td>46</td>
</tr>
<tr>
<td>Sorting</td>
<td>47</td>
</tr>
<tr>
<td>Multiple Sorts within a Report</td>
<td>47</td>
</tr>
</tbody>
</table>
Icons Used In This Guide

**Information:** This icon serves as a general “FYI” and is used to provide you with background information that you may find useful.

**Alert:** This icon is used to signify a warning or alert that something involved in the current process could potentially cause a problem.

**Note:** This icon is used to inform you that there could be something here worth paying attention to.

**Try It:** This icon demonstrates that it’s time to try to perform an action yourself. Follow the steps provided and give it a try.

**Stretch Your Thinking:** This icon encourages you to stretch your thinking with both introduced and unimplemented material.
Preface

Implemented at Princeton in 2005, the Cognos BI suite integrates with many Princeton applications to provide business intelligence services, including reporting abilities to PeopleSoft HR, PeopleSoft Financials, and PeopleSoft Student, as well as other non-PeopleSoft related applications including Labor Accounting, Time Collection, and University Housing. The Information Warehouse utilizes Princeton’s LDAP environment to provide authentication.

Specific departments within the University community take ownership and govern the data in the Information Warehouse. To acquire access to a specific package, please contact the appropriate package custodian. For further information about accessing and/or using data, please refer to http://cedar.princeton.edu/access-%26-use-data.

- Information in Princeton’s Information Warehouse is 24 hours old
- Cognos Analytics can work with the following browsers:
  - Chrome
  - Firefox (issues)
  - Internet Explorer
  - Microsoft Edge (issues)
  - Safari

Content in this book is based on fictitious data sets represented in CeDAR’s Training Package in the Information Warehouse.

Introduction

Welcome to Cognos Analytics! Princeton University has upgraded to the latest release of IBM’s Cognos BI tool, (Cognos 11.1.3). IBM provides a modern, user-focused interface, which emphasizes self-service and user experience while delivering strong BI capability.

This tool features a consistent user experience while moving from capability to capability. The portal, the reporting tool, and the dashboard/story tools are within a single browser tab.

What Remains the Same

For those who have been working with Cognos, many features remain the same including:

- Working remotely you still need to VPN in
- Left navigation bar
- Your data, folder directories, report names, prompts, run formats, schedules, security
- Content in My Folders and Public Folders

What’s New and Different

For those who have been working with Cognos, some new features include:

- The interface, which replaces Cognos Connection, Report Studio, Query Studio, and Workspace Advanced
- New and improved search functionality
- Ability for users to interact with data upon running reports (contingent on security permissions)
- Ability for users to upload data (contingent on security permissions)
- Dashboard and storyboarding functionality (contingent on security permissions)
- Subscriptions for consumers in addition to) schedules
- A new link directly to the Tableau server for those who have access to Tableau
About the Warehouse
The Princeton University “Information Warehouse” is the reporting data repository available to the Princeton Community. Consumers of this data can access reports through the IBM tool, Cognos Analytics. Data sets inside the Information Warehouse (IW) accurately represent information in the corresponding source, or source system. On a daily basis, all source systems (such as PeopleSoft Financials or Time Collection) feed their data into IW reports. Information within the IW is considered twenty-four hours old.
The CeDAR Website
CeDAR’s website communicates information to the Princeton Community, as it pertains to the Information Warehouse (IW) including:

- Who to contact to gain access to reports
- Cognos outages and downtimes
- Data loading discrepancies

The URL to the CeDAR site is https://cedar.princeton.edu.

The Information Warehouse can be accessed several ways:

- Click the link at the top of the CeDAR homepage to Enter the Warehouse.
- Click the IW & Tools tab on the homepage menu: https://cedar.princeton.edu/iw-tools. This will lead you to a list of URLs to choose from.
- Choose Information Warehouse from the shortcuts listed on the right navigation of the homepage.
Logging into Cognos Analytics

To log into Cognos Analytics (the Information Warehouse), choose any of the methods on the previous page. You will need to authenticate with a valid Princeton NetID and password to enter the Warehouse.

Logging into the Information Warehouse from an offsite location (off of the Princeton Network) will require you to use a Princeton Secure Remote Access (SRA/VPN) Connection.

Additional Ways to Enter the Information Warehouse

In addition to logging in via the CeDAR website, users enter the Warehouse in several other ways. Reports can be accessed through external links, PeopleSoft or STRIPES, and/or bookmarked/favorited URLs. Reports are frequently accessed directly from the Princeton Prime Financials Reporting tile found on www.princeton.edu/prime.

Finance and Treasury offers additional reference materials (guides, step by steps, and videos) for ease of navigation and convenience.

https://finance.princeton.edu/how-to/prime-information-trainin/

If you have any questions or concerns you can contact the Financial Service Center.
User Experience

The interface allows for consistent experience as a user moves from viewing content to creating advanced reports and dashboards. All users work within the same interface with their respective security permissions.

The Welcome Portal

The Content Explorer is also called the Welcome Portal. This is where everything happens. From the Welcome Portal you will run reports, search for content, view content, open dashboards, stories and other items, upload files, check your notifications, and set your preferences and home page.

If you should see these glowing green/blue dots, they are called coach marks (or hints). They are there to help guide you through the portal as you get started using Cognos Analytics.

When these hints are no longer necessary, you can easily turn them off by clicking one of them and selecting Turn off Hints.

Clicking the X on the top right corner will turn off that particular hint.
You can turn all hints on or off from My Preferences under the Personal Menu and checking/unchecking the box next to Show hints.

Depending upon your screen’s resolution you may or may not see additional information beside the icons on the Left Navigation pane. Increasing or decreasing your zoom level will determine whether the Left Navigation pane is expanded or collapsed.

The Welcome Portal offers tiles for quick access to work with items you’ve recently used. By default, you will see six live tiles. If you wish to see more recently used objects listed, click the Show More link. Clicking the More Button will reveal an action menu and allow you to take additional actions.
My Content, Team Content, Packages, and Folders

The Left Navigation pane includes tabs for:

**Home** - is your Welcome page and recently viewed reports area.

**Search** - allows you to search for packages, folders and reports.

**My Content** - is a user’s secured area to any content saved there. Only the user can access this area. Reports saved to this area can be modified. You can create new directory folders here. You can also copy reports or save report views to this folder.

**Team Content** – contain reports or other objects that you have permission to view or access. You cannot modify or personalize reports in these folders.

**Recent** - This fly-out window shows up to 20 recently viewed items.

**Recent Items**

Click directly on a report name to run it or hover over a report/object name to reveal the More button to expose a list of new actions.
Search and Find Content
Whether you’re looking for reports, dashboards, stories, data, files, folders, packages or other items, you can find any object you’re looking for by opening your My Content or Team Content folders, or by checking your Recent list. However, the Search is a quick, easy way to find exactly what you’re looking for.

To find items, type keywords into the Search field. As you type objects that meet your search criteria will begin to populate below the search window. You can also search for text including table or column labels, XML report specifications, URL items, shortcuts, templates, and more.

Search does not return results for content that is archived. You can access archived content from a report that’s listed in one of your folders.

Narrow Your Search with Filters
If your search returns too many results, you can click the Filter icon to narrow your criteria.

The option to filter is only available after you perform an initial search.

Save Your Search
After you search and the results are listed, you can Save your search for future use. If filter options were included in your search, these options are also saved and listed under Saved Searches.

The option to Save is only available after you perform an initial search.
Navigation
The user interface affects how you move around in the tool. Here are some navigation tips!

Welcome Menu (Page Switcher)
The Cognos Analytics Welcome Portal is the default Home page. Clicking the drop-down on the Welcome Menu/Page Switcher and selecting Welcome will always return you to this landing page, which may not necessarily be your “home page”.

More/Set as Home
You are encouraged to click the More button anytime you see it, especially as you get used to the user interface. Depending on where you are in navigation, capabilities behind the More button may change.

If you prefer, it is possible to make other content (like reports or dashboards) your Home Page.
Click the More button on the application toolbar and select Set as home.

Home Button
The Home button will return you to your home screen in a single click.
This is a more direct route to your home page than using the switcher if you have chosen a new home page.

You can switch your home page from the Welcome Portal to a report or dashboard.
Cognos Analytics offers the ability to have multiple objects open at the same time (in the current session) making it easy to quickly switch between them. Once a report is run, it will remain open in the Welcome tray.

You can close objects that are open in the tray by clicking the to the right of the object name.
Clicking back to an open report from the tray (or list of live tiles) will not “re-run” the report or allow you to choose new prompts. It will only return you to the report’s last generated output. If you need to re-run your report, you need to reset your prompts or close the active report from the Welcome tray.

Notifications
Alerts are indicated as numbers next to the Notification (bell) icon. As subscribed reports finish executing, the number of alerts will increase.

Personal Menu
Use this area to adjust settings related to you as the user, to change preference settings, to easily make any modifications to your schedule and subscriptions, and to logout.
Exploring Content

The fly-out menu lets users explore content within their folder(s) as well as perform other administrative tasks depending on permissions.

Hovering over a report (or other object in the content pane) will reveal the More ellipsis button. The More ellipsis button provides an Action menu, which houses many of the tasks you can perform for that particular report/object.

Clicking around and exploring is the best way to become acclimated to the tool, as well as discover how things work in the user interface.

Viewing and Interacting with Content

When you find a report you would like to run, you have several options:

(A) Navigate to the desired report from My Content or Team Content on the Left Navigation menu and click directly on the report name.

(B) Hover over the desired report and click the More button to the right of the report. Choose Run as and select a method to run the report to a specific output type.

Use the breadcrumbs to navigate within the content and get out of a buried destination within your folder directory.

Use the Filter button to narrow the contents viewed in the pane.

By clicking the Sort button (up/down arrows), you can sort content in ascending or descending order by name or last modified date.

Resize the content pane by clicking and dragging the two small lines on the border of the pane to the desired location.
(C) If you’d like to run a report that you’ve recently worked with, click in the white space of the live tile on the Welcome Portal.

(D) Click the More button on the bottom right of the live tile.

*Once a report is opened in a current session, it will remain open in your Welcome Menu/Page Switcher and held in memory until you close it (or the session). Clicking on an already-opened report from the live-tiles or Welcome Menu will launch the report with its last generated output.*

(E) Navigate to a report via the Recent icon on the Left Navigation menu.

After you run a report to HTML, you can change the format of the output by selecting the Run as button in the More (...) pull down menu, and choosing a new output from the list that appears in the menu. This will re-run the report with the prompts that you have already selected.

To run the report with different prompts, select the Run button and select Reset prompts and run.
**The Action Menu**

By right-clicking a report or by clicking the **More** button to the right of the report name, an **Action Menu** will appear. Depending on your security access, you may not see everything in this menu.

**Run as:** Allows you to choose from a list of desired output and to run directly to it. Also allows for the option to **Run in background**.

**Edit report:** Opens your report in authoring tool allowing you to make changes/edits to the original report (Report Authors only).

**Create report view:** Creates a report view of the report in your My Content. Usually used to create a dynamic copy of the report for scheduling.

**View versions:** Displays any previously saved report output.

**Create a new job:** Creates a new job to run the report on a regular basis.

**Share:** Copy link to share content with other users

**Copy or move:** Copy or move a report to another destination within Cognos. The user must have write access to the other destination. A user can copy anything to their My Content area.

**Create shortcut:** Used to create a shortcut of the report in My Content.

**Properties:** Displays the report owner, when the report was created and last modified, and reveals the report description, if applicable.

**Report Properties**

To get to the Properties of a report, navigate to the report, click the **More** button to reveal the action menu and select Properties.

The **Properties pane** will open.

Hover over the report title or the report description to reveal the **Edit** icon. Click the icon to edit.
The **Report** Tab allows you to change default run formats and set prompts for the report.

![Report Tab](image)

The **Schedule** Tab allows you to create a new schedule for a report or update an existing one.

![Schedule Tab](image)

**Password Protecting PDF Documents**

To control the ability to alter or manipulate PDF documents, you have the ability to password protect them.

- Navigate to the **Properties** of the report.

![Properties](image)
• From the **Report** tab, click the drop-down arrow beside **Report options**.
• Then click **Set PDF Options**.

![Image of Report Options](image)

• Check the box next to **Requires a password to open the report**.
• Set and confirm the password.

**Prompts**

Many of our reports have a prompt page that we see prior to the reports execution. This helps make reports more versatile for more users. It also helps the report process faster by limiting the amount of data coming back from the database.

• Prompts can be on one or more pages.
• Prompts can be optional or required. An asterisk (*) indicates that the prompt is mandatory.
• Finish/Submit/Run buttons are grayed-out until a mandatory prompt is selected.
• Prompt properties can include single or multi-value selection.
• Ctrl+click to select multiple values within the prompt box.
• For convenience, some prompts have Select all and De-select all links below the prompt.
• All prompt pages contain a Cancel, Submit, Finish, Run, or OK button to either cancel or execute the report.
• If prompts are optional and none are selected, the report may take longer to complete.
• Prompt pages can have different looks. Report Authors have the ability to create designs and layouts based upon their best use choices for the data and report.

![Image of Prompt Page](image)
Drill Through Reports
Some reports may contain drill through links. A drill through is a capability which allows users to see more specific details of a general report by opening an additional (or child) report. Drill-throughs are indicated by a blue hyperlink. When a hyperlink is clicked, the browser window opens for the drill through (or child) report.

<table>
<thead>
<tr>
<th>Academic Program</th>
<th>Academic Program Descr</th>
<th>Academic Track</th>
<th>Dept Code</th>
<th>Academic Dept</th>
<th>Faculty Count</th>
<th>Term Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>BA</td>
<td>Bachelor of Arts</td>
<td>Language and Human Development</td>
<td>DEPTANT</td>
<td>Anthropology</td>
<td>18</td>
<td>201002</td>
</tr>
<tr>
<td>BA</td>
<td>Bachelor of Arts</td>
<td>Language and Human Development</td>
<td>DEPTANT</td>
<td>Anthropology</td>
<td>18</td>
<td>201202</td>
</tr>
<tr>
<td>BA</td>
<td>Bachelor of Arts</td>
<td>Language and Human Development</td>
<td>DEPTANT</td>
<td>Anthropology</td>
<td>18</td>
<td>201302</td>
</tr>
<tr>
<td>BA</td>
<td>Bachelor of Arts</td>
<td>Language and Human Development</td>
<td>DEPTANT</td>
<td>Anthropology</td>
<td>17</td>
<td>201501</td>
</tr>
<tr>
<td>BA</td>
<td>Bachelor of Arts</td>
<td>Language and Human Development</td>
<td>DEPTASN</td>
<td>Asian Studies</td>
<td>12</td>
<td>201401</td>
</tr>
</tbody>
</table>

Report Options
There are several options for running a report.

- You have the option to subscribe to the report.
- You can save it as a report view.
- You can run it to several output types (Excel, html, csv, etc.)
- If you are a report author you can make edits to it in the Reporting tool.
- If interactivity mode is turned on you have this new reporting feature.

The options available to you depend upon the type of report and the permissions you have been given in Cognos. Choose the options that best suit your needs for viewing frequency and personalization.

- If you want to see and run a report on a regular basis, subscribe to it.
- If this report location is where you start from each day, you can set it as your home page.
- If you entered prompt and parameter values in the past and you would like to save them so you don’t have to enter them each time you go to run the report, save the report as a report view.
- If you choose to edit the report, the report opens in Reporting with all the tools you need. Depending on the item type, the appropriate actions are available in the viewer.

Subscriptions
Cognos Analytics has simplified the scheduling process through its Subscriptions feature. Subscriptions allows the user to quickly schedule a personal copy (or report view*) of the report.

*See section on Report Views.

The Subscribe feature can only be used after the report has been run. This feature is found on the right side of the orange toolbar under the More button. Subscriptions automatically create a report view in your My Content area. The reports you subscribe to will be delivered to you with custom prompt values and options you have selected.

Subscribing to Reports
End-user schedules are called subscriptions. If you use a report regularly, consider subscribing to it. When you subscribe, you pick the time, date, format, and where you want it to be delivered. The subscription includes all your prompt and parameter values.
The subscription option is available when you run and view a report. Subscribe is not available in edit mode or when you view saved output. If you edit a report, you must save it before you can subscribe to it.

When you subscribe to a report, you are notified each time it is delivered. You will see a numeric alert on the Notifications icon. Click to view any messages, which will contain a link to view the report output.

See section on Notifications for more information.

You can schedule reports for broader distribution. A schedule can be created on objects saved in your My Content folder.

Notifications
Notifications help you stay on top of important data. If you subscribe to a report or a report view, you are notified each time your subscription is delivered. If you view saved output and you want to know when there’s a new version of the report, you can tap the Notify Me button.

The Notify Me button is available from the More button in the application toolbar only when you view a saved output version of a report.

If you request to be notified when someone runs the report, you receive a notification with a link to the updated version.

When you subscribe, if you choose the Save the report on the system delivery option, you receive a notification with a link to the new report version. To view a list of all your notifications, click the Notifications button on the application toolbar.

Schedules
Whether you need to run your report on a daily basis or only every so often, the Scheduling Tool in Cognos Analytics makes it possible to schedule your reports to run automatically, as frequently as you need.

Your original report can only have one schedule associated with it, so it is a best practice to create a Report View (or multiple report views, as needed), which keeps the original report intact and allows you to create as many unique schedules for each report view as necessary. Each schedule can have a different frequency, distribution, and delivery option attached to it. *See section below on Report Views

To create a new schedule on a report or report view:

- Navigate to the Properties of the report in the fly-out menu under the More ellipsis (...) button.
- Click the Schedule tab and click .
- Enter appropriate criteria in the top half of the Schedule Creator.

Once you have chosen how often you would like your schedule to run, pay special attention the options that follow:

Format: Choose from a list of output types
Delivery: Choose to send report by email, print the report, or save the report.

Prompts: Set or clear prompt values

PDF: Choose the layout and password protect a PDF (if desired)

- Click Create

**Managing Your Schedules and Subscriptions**

You can view and manage all of your schedules and subscriptions by accessing them on the **My Schedules and Subscriptions** panel from the Personal Menu of the application toolbar. You can enable, disable, modify, or delete entries and view their saved outputs or archived versions. If you view the versions, you can also open the version details panel for information such as the run status, error messages, and run time.

**Report Views**

While your report is still open, you have the option to **Save report as report view**. Creating a Report View is simply storing the output of the report in a specified format (html, pdf, etc.) for specified prompt conditions. They are a combination of a shortcut and a dynamic copy of the original report. So, if you have a report that you want to run with different prompt values, schedules, delivery methods, run options, or output formats, you would create a Report View.

The Report View will always refer to the report from which it was created. Any changes or modifications that are made to the actual report, after creating the Report View, will not be captured in the Report View until you re-run it.

*Creating a report view does not change the original report.*

If you would like to edit the prompt values for the Report View, open the **Properties** panel. In the Properties panel for the Report View, you will see a link to the source report.

*If the source report is moved to another location, the Report View link is maintained. However, if the source report is ever deleted, the Report View link will break.*

**Editing Reports**

After you have run your report, Report Authors will see an **Edit** icon in the top left orange toolbar. Clicking this opens **Reporting** and, allows you to make changes to your report in authoring mode, as long as you have been granted that capability.

See section on **Reporting in Cognos Analytics** for more information.
### Report Output Options

The **Run as** option under the **More (...)** button to the right of the report name allows you to choose and run your report to a new desired output format.

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
</table>
| HTML   | - Default output  
         - Web based and designed for viewing report output on-screen  
         - All pages are displayed and accessible for any report containing tabbed layouts |
| PDF    | - Used for printing and distributing output in Adobe Acrobat Reader  
         - Each page in a tabbed layout report will render its own page |
| EXCEL  | - Previously named Excel 2007 Format  
         - Supports lists, crosstabs, icons, titles, subtotals, totals, and charts  
         - Each page of a tabbed layout will render as its own worksheet |
| EXCEL DATA | - Contains raw data of report  
             - Report formatting (titles, charts, icons, subtotals, totals, etc.) are dropped and data is returned in spreadsheet format  
             - Only the first page of tabbed layouts will appear |
| CSV    | - Exported data which is tab-delimited and can be imported to (or read by other software)  
         - Strings are not enclosed in quotation marks  
         - CSV exports show only the results of the report query  
         - Page layout items, such as titles, images, totals, and subtotals do not appear |
| XML    | - Files that contain the .xml file extension are structured text files that contain custom tags that allow the transmission of files across applications  
         - Running reports to XML will reveal code |

### Interactivity Mode

Interactive reports provide interactivity in the report output and will have context sensitive menus that will appear above the object. For example, in a report with Interactivity Mode turned on, you may be able to:

- Change the sort order
- Set or edit filters
- Change the aggregation
- Group a column
- Change the type of data container (i.e. to a chart)
- Save the changes as a new report
- Interact with charts

There are interactive and non-interactive reports. All existing/upgraded reports were brought over with interactivity mode turned **off**. If necessary, however, these changes can be made at a report level (or at the package level), by your package custodian.
At the discretion of your Package Custodian, reports written in Cognos Analytics may or may not be created with Interactivity Mode turned on.

Report Versions
If you run reports, you will see the latest data from the data source. However, when you view report versions and outputs, such as when a report you subscribe to is delivered, you’re viewing the data that was captured when you saved the version or view of the report.

Report outputs are generated by subscriptions, schedules, multiple formats, bursting, and delivery methods that include save, print, and email. In many instances, you are notified and receive a link to view report output, but you can also view saved and archived versions for reports in your content lists.

To view report versions and archived versions:
For a report in a content list, click the More button next to the report name and then select View versions.

To save a report version:
In the application bar, when you view a report, click the Save button. You may also have the Save as option of saving the report version under a different name or in a different location.

To delete saved outputs for report versions:
For a report in a content list, click the More button. Select View versions and click on an entry in the list. Then select delete.

Deleting removes all saved output formats of the version.

Bursting Reports
Burst a report to distribute its contents to various recipients. Bursting is the process of running a report once and then distributing the report output to recipients who view a subset of the data.

To burst a report:
• Navigate to the appropriate report and hover over it to reveal the More button.
• Click the More button to reveal the Action Menu and select Run as.
• Activate the **Run in background** button. Slide the button to the right. Notice that this activates the **Advanced** feature below the report output options.

![Image of Run in background button]

• Check the box next to the output format you prefer.
• Click the **Advanced** caret to expand the section.

![Image of Advanced section]

Choosing **Later** here will allow you to set a time/date for the report to be bursted. *[Current Best Practice]*!

![Image of Later option]

• Expand the **Delivery** section to reveal Delivery options.

![Image of Delivery section]

• You have the option to:
  - Send report by email
  - Print report
  - Send report to mobile device
  - Save report (checked by default)
• Place a checkmark in the box next to **Send report by email**.
• Place a checkmark in the box next to **Attach the report**.
• Edit the **Recipients** and the **Subject** line.
• You may also create your message here.

• Scroll down and click **Done** when ready.
• After returning to the **Run as** screen, click **Run**.
• **Enter Prompts** as appropriate.
Reporting in Cognos Analytics
Reporting in Cognos Analytics - Overview

Cognos Analytics features a consistent user experience with a singular user interface. The portal, reporting, dashboarding, and stories are all inside a single browser tab, creating a common look and feel. The interface allows for a consistent experience as a user moves from viewing content, to editing content, to creating advanced reports and dashboards.

Modifying Existing Reports

Report authors modify existing reports in the same window the report is being viewed in.

- Run a report.
- Using the Edit icon, you can switch into the authoring interface.
- The Edit icon is used to enter and exit the authoring interface.
Report Function Mapping
Here are a list of features and functions that will appear in the Reporting interface.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Folder]</td>
<td>Save: Save as; Save as Report View; Convert to template</td>
</tr>
<tr>
<td>![Pen]</td>
<td>Edit: Toggle between editing and viewing the report/dashboard</td>
</tr>
<tr>
<td>![Unlock]</td>
<td>Welcome: Page Switcher; Switch between open reports and welcome portal</td>
</tr>
<tr>
<td>![Unlock]</td>
<td>Page Views: Design; Preview; Structure</td>
</tr>
<tr>
<td>![Unlock]</td>
<td>Properties: Report level; Run options; Validate options; Burst options; Interactivity; Layouts; References; Formats; PDF; Drill Up/Down/Through ...</td>
</tr>
<tr>
<td>![Unlock]</td>
<td>More: Locked; Options; Layout Components; Conditional Styled; Clear all Parameters</td>
</tr>
</tbody>
</table>

The **Data Pane** and the **Toolbox** are available in **Edit** mode for report authors.

The **Report** tab contains:
- Report overview
- Report pages
- Prompt pages
- Queries
- Classes
- Variables
Creating a Report

In Cognos Analytics you create a report within the browser.

- From the Left Navigation menu click the **New** button.
- From the pop-up menu, select **Report**.

Templates and Themes

Cognos Analytics includes numerous basic report templates and color themes that can be chosen. Within the list of templates, you will find several Princeton standards.

While you are encouraged to choose a Princeton template, you can also choose from a blank list or crosstab or create your own.
Choosing a Package

A Package in Cognos Analytics refers to the connection to the database for a given data set. It contains a business view of the data that is used to create reports.

- Packages are denoted by an icon resembling a file drawer
- No reports are ever saved to a “file drawer” or package

To choose a package, click the Select sources button or the Add a source button.

A dialog box will open listing any package(s) in which you have access.

For this training we will navigate to:

Team Content > Training Data – Reports > Training Data
Cognos Package > Training Data.

Select Open when the button is activated.

Your source data will load in the Insertable objects area allowing you to choose from query items for your report.
Reporting Interface

Icons on the interface reveal options and functionality related to report authoring.

When on a report page the gray navigation panel on the left includes the Home and Insertable objects buttons.

Above the report page is the Report tab.

Above the report page is the Report tab. In the pull-down menu you can access the Report, Pages, Prompts and Queries that you are working on.

You can also access Classes and Variables in this menu.

As we build reports we will be working on the Report page, on the Prompt page, and on the Queries page.

**Home:** Returns you to your home screen/welcome portal. Your report will remain open.

**Insertable objects:** Your Sources and Toolbox tabs are located here.

**Sources tab:** Access your packages, query subjects and data items here.

**Toolbox tab:** Your report objects can be found here.

**Queries:** Manage your query items and condition explorer here.

Queries:
Insertable Objects Pane

After your Package opens, it is visible in the Sources tab. Use the Insertable objects pane to access data and Toolbox items.

Select the Sources tab to view the entire metadata tree.

The Toolbox

The toolbox contains report objects such as text, query calculations and graphics.

Toolbox items are organized into groups. You can quickly search for an item in the toolbox.

Items used most often can be added to the Pinned group. Right click on the item and click Add to Pinned Toolbox Items.

To remove or re-order pinned items, right-click the item, and select your option in the window.

Items in the Pinned group appear around the Add Objects menu when you create a new report.
To expand or collapse the view of the toolbox when items are displayed as a tree, click the buttons on the top, right.

To change the view of the toolbox so they appear as icons, click the grid in the top-right corner.

**Report Tab Pages**

Use the Report Tab Pages button to create new report pages, view existing report pages, add a Page set (add a page break) or add a Report reference (point to an existing report).

- Click the Add page button to create a new page.

- When Prompt pages are selected under the Report tab the Add page button will create a new Prompt page.

**Queries and Conditions**

Use the Report Tab Queries button to create or modify queries. You can also add or modify joins, unions, intersections, exceptions and add or modify SQL or MDX statements.

Click the Add (+) button beside Queries to create a new query, or drag a query from the Toolbox over to the query canvas.

*Right-Click the Query to View Tabular Data.*
Report Specification

The report specification defines the queries and prompts used to retrieve data, and the layouts and styles used to present the data.

Exploring Page Views

Reporting in Cognos Analytics offers three views in which you can author reports: Page Design, Page Preview, and Page Structure.

View options are located in the top right white toolbar.

- **Page Design**: In this view, you can see how your report is set up. You will see the results of the report when you run it.

- **Page Preview**: Cognos Analytics shows you the current report page with live data. In this view, you can edit the report.

- **Page Structure**: Displays an overview of all of the report objects in your report in a tree structure, organized by page.

  Using a tree structure is useful for locating the objects on a page and troubleshooting problems with nested objects.

  To switch between views, click the **Page Views** button on the application toolbar.
Properties Pane
You can view the different property sheets by clicking the Ancestor button after clicking into the Properties pane.

Click the Properties button to open and close the Properties Pane.

The Properties pane provides a comprehensive view of the data selected in the area in which you are working. And you can make changes to many areas within your report from here. Clicking around in different areas within the report will reveal different properties.

When the Properties pane is open and you click within your report, a contextual (on-demand) toolbar will appear allowing you to do something as simple as sorting, to changing the ancestor, to changing the visualization, itself.

Anytime you see the More button (…) click it! You will find more action items behind it.
**Interactivity Mode** can be turned on or off using the **Properties** pane within the report.

Use the Ancestor button to navigate to the **Report** page.

![Interactivity Mode](image)

**More Options**

The **More** button on the top menu of the Reporting interface reveals additional options to assist you with manipulating your reports to achieve the expected outcome.

![More Options](image)

**Locked/Unlocked**: To manipulate the content of some objects, you may need to unlock the object.

**Options**: Adjust default for page views and on-demand toolbars as well as other advanced settings.

**Layout Components**: Allows you to create reusable layout objects within reports and share those objects in other reports.

**Conditional Styles**: Add conditional styles to your report to better identify exceptional or unexpected results. A conditional style is a format, such as cell shading or font color that is applied to objects if a specified condition is true.

**Clear all Parameters**: Click to clear stored parameter values.

When adding Measure fields to list reports, Report Studio was good about adding facts together for you. In Cognos Analytics, there is an **automatic group and summary** applied along with totals. You may or may not find this helpful.

**Turning Off this Functionality**

- Check that you are in **Edit** mode.
- Click **More > Options**.
- Click on the **Report Tab**.
- Uncheck the box next to **Automatic group and summary behavior for lists**.

![Turning Off this Functionality](image)
On-Demand Toolbar

The On-Demand Toolbar is a context-sensitive (or contextual) toolbar that changes based on the type of report object and data you have selected.

Select an object in your report to activate the on-demand toolbar.

Adding filters, grouping, apply formatting, all change your reports and visualizations.

Show On-Demand Toolbar on Right-Click Only

You may have noticed that Cognos Analytics defaults to show the On-Demand Toolbar every time you click in your report. This can become a nuisance.

You have the ability to change this so that the toolbar only appears when you right-click within your report.

To do this:

- You must first be in Edit mode
- Click the More button and select Options
- Place a check in the box next to Show on demand toolbar on right-click.
- Click OK
Turning Interactivity Mode On/Off

As previously mentioned, Interactive reports provide, as the name suggests, interactivity in the report output and will have context sensitive menus that will appear above the object such as filters and grouping.

There are interactive and non-interactive reports. All upgraded reports (those that originated from previous versions of Cognos that have been moved into Cognos Analytics) were brought over with interactivity mode turned off. At the discretion of your package custodian, this feature can, however, be turned back on.

As a report author it is important to understand that when creating NEW reports, Cognos Analytics defaults to having Interactivity Mode turned ON. If it is not the intention of the data stewards to allow end-users (report viewers) to interact with your reports, you are responsible for being in the practice of turning this functionality off.

It is a best practice to turn this functionality off when beginning a new report and before you save this report for the first time.

To do this:

- When creating a new report, after selecting your template and before selecting your data source, click on the Report tab and select Report, to open the Report properties window.
- In the Properties window go to Report > Running & Validating.
- Change Run with full interactivity from Yes to No.
Creating and Modifying Reports
In this section, we will create a new report, explore the data model, and make modifications.

Creating a New Report in Cognos Analytics

1. From the bottom Left Navigation, click **New** and select **Report** from the list to create a new **Report**.
2. Turn Interactivity mode **OFF**, per page 41 instructions.
3. From the list of templates, choose the **01-Princeton - List Report**. Double-click on the report or select **OK**.
4. From the **Insertable objects** window, click the **Add a source** button or the **Select sources** button to select a Package.

5. From the list of Reports and Packages navigate to:
   
   **Team Content > Training Data – Reports > Training Data Cognos Package > Training Data.**

6. Select the **Training Data** Package and click **Open**.
1. Expand the data model to list the query subjects (tables) and query items (fields).
2. In the Source pane navigate to:
   Training Data > Presentation Layer > Fictitious Training Data > Person Bio Data.
3. Open the Person Bio Data table.
4. Drag or double-click to bring a single field into the report. Control-click to select multiple query items.
5. Add the following fields into your report:
   - EmplID
   - Last Name
   - First Name
   
   To add fields to the report, drag the entire selection to the table to the right until you see a blinking, black insertion point as shown below (single lane road with blinking median).

6. Add the following additional items to the report:
   - Home Address Street
   - Home Address City
   - Home Address State
   - Home Address Postal Code
   - School ASC
Validating a Report

Validate your report to ensure it contains no errors.

To validate your report:

1. To the right of the Page design menu click on the Cog to open the pull-down menu.
2. Select Validate report.

You will see this message if the report is valid. Click OK.

Another way to Validate a report:

2. The Validate button is next to the Copy and Paste buttons.
3. Select Validate report.

You will see the above message if the report is valid.

Running a Report

Running a report is generating the output using the criteria and report definitions in the report.

1. Click the Run Options button from the application toolbar.
2. Choose Run HTML (or any output format you wish to view your report).

A new tab name New report will open with the report output of your query.
Saving Report Output
The report is in the Report Results window. You have the option to save report output.

1. From the application toolbar, click the **Save as** button. The **Save as** dialog box will open prompting you to choose from the **Team Content** folder or the **My Content** folder.
2. Select the **My Content** folder.
3. In the **Save as:** field, name the report, **Personal Bio Report OUTPUT**.
   Click **Save**.
   The report output is saved in your **My Content** folder.
4. **Close** the results Report Output window.

Saving a Report
To save the current report, return to the **New report** tab in your browser.

1. From the application toolbar, click the **Save as** button.
   The **Save as** dialog box will open prompting you to choose from the **Team Content** folder or the **My Content** folder.
2. Select the **My Content** folder. In the **Save as:** field, name the report **Personal Bio Info Report**.
   The report is now saved with the new file name under your **My Content** folder.

⚠️ **If you have already saved a report and continued to modify it, clicking directly on the **Save** button will overwrite what you have already saved. Clicking the drop-down arrow beside the **Save** button will list other **Save options.**
Removing a Column
You may need to remove a column. The information may no longer be needed for reporting purposes, or you may need to omit sensitive information/details for certain recipients.

1. Select the School ASC column header (the last column).

<table>
<thead>
<tr>
<th>EmpId</th>
<th>Last Name</th>
<th>First Name</th>
<th>Home Address Street</th>
<th>Home Address City</th>
<th>Home Address State</th>
<th>Home Address Postal Code</th>
<th>School ASC</th>
</tr>
</thead>
<tbody>
<tr>
<td>EmpId</td>
<td>Last Name</td>
<td>First Name</td>
<td>Home Address Street</td>
<td>Home Address City</td>
<td>Home Address State</td>
<td>Home Address Postal Code</td>
<td>School ASC</td>
</tr>
<tr>
<td>EmpId</td>
<td>Last Name</td>
<td>First Name</td>
<td>Home Address Street</td>
<td>Home Address City</td>
<td>Home Address State</td>
<td>Home Address Postal Code</td>
<td>School ASC</td>
</tr>
</tbody>
</table>

2. Press Delete on the keyboard to remove the column.

3. Click directly on the Save as button to overwrite the previous save.

Source Tab VS Data Items Tab
As you make changes to the report, the items from the Source tab (or data model), never change. The Source Tab contains all the data available in the Package, whether you use it in your report or not. By contrast, the query represents query items (or fields), used in your report. The query may or may not change as you edit your report, depending on the kind of modifications you make. For example, when we used Delete to remove the column, in the exercise above, the column was deleted from the query, and is no longer found on the Data Items Tab.

To remove a column from the report, and keep the data item in the query, use the “cut” function to cut the column from the report page.

⚠️ Cutting a column instead of deleting a column leaves the data item in the query and does not display the column on the report page.

We’ll learn how to remove a column from the report while keeping it in the query using the cut function a little later.

1. From the Insertable objects window, click the Data Items Tab (between the Sources and Toolbox tab).
2. Examine the query.
3. Notice that each Query Item listed is a field that is visible on the report.
4. Notice the School ASC field that we deleted is not visible on the Data items tab or in the Report.
5. Click back onto the Sources Tab.
6. Scroll through the Query Items listed in the Person Data query subject. Notice items that do not appear in the report are still in the data model, including the column we deleted from the report.

**Sorting**

You can sort items to view them in a preferred order.

By default, Cognos Analytics retrieves items in the order defined in the data source.

In this exercise, we will sort the report data, add a multiple sort, and remove a sort.

1. Click the column heading of the Last Name field.
2. From the contextual toolbar that appears, click the Sort icon.
3. From the drop-down menu, click Ascending.

4. Notice that the sorting indicator caret appears in the column header now.

   *When the triangle/caret points up, the column is being sorted in ascending order, from A to Z, or from smallest to largest for numeric data.*

5. Click the Run button to run the report.
6. Notice that the Last Name is sorting ascending.
7. Close the New report results window tab.
8. Save the report.

**Multiple Sorts within a Report**

Multiple columns can be sorted within the same report. Sort order can be different for each column.

In this report the primary sort is an ascending sort on Last Name.

We will change First Name to sort in descending order after the Last Name sort is applied to the data.
1. Highlight the **First Name** column heading.
2. From the drop-down arrow beside the **Sort** icon on the contextual toolbar, select **Edit Layout Sorting**.

3. Drag the **First Name** field from the **Data Items** window into the **Groups** window.
4. Place **First Name** under **Last Name** in the **Detailed Sort List**.

5. With the **First Name** field selected, change the sort order to **Descending** by clicking once on the **Sort Order** button on the bottom of the window.
6. Click **OK**.
7. Run your report.
8. Note the sort order for **Last Name**: Abraham. The **First Names** are now sorted descending.
9. Close the **New report results** window.

**Removing a Sort**
A sort can be undone.

1. Click the **First Name** column heading.
2. Click the **Sort** button from the contextual toolbar and select **Don’t Sort**.
3. Click **Save** to save the changes to your report.
Hiding Columns

Now, we will use the **Cut** function to remove columns from the report. This hides the columns from the report page. Although the data is no longer displayed in the report, using the **Cut** function retains the data item in the query. This allows us to use the item for other purposes such as sorting on the hidden column.

1. Click **Last Name**, then Ctrl+click **First Name** to select both column headings.
2. From the contextual toolbar, click the **More** button to view additional functions/action items.
3. Select **Cut**.

![Image of report with Last Name and First Name columns highlighted and contextual toolbar with Cut option highlighted]

The columns (**Last Name** and **First Name**) are now removed (but only hidden) from the report.

![Image of report with Last Name and First Name columns removed]

4. From the **Report** tab, click **Q_List1** under the **Queries** icon.

The query items which make up the query will be listed in the **Data Items** pane on the right. Notice the **Last Name** and **First Name** columns are still in the query.

![Image of query items with Last Name and First Name still selected]
5. **Run** the report.

The report is still sorted by **Last Name** although the column has been hidden.

<table>
<thead>
<tr>
<th>EmplID</th>
<th>Home Address Street</th>
<th>Home Address City</th>
<th>Home Address State</th>
<th>Home Address Postal Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>304C596F</td>
<td>40 6th Road</td>
<td>Reston</td>
<td>VA</td>
<td>22101</td>
</tr>
<tr>
<td>300787A1</td>
<td>60 Almo Circle</td>
<td>New Castle</td>
<td>PA</td>
<td>19041</td>
</tr>
<tr>
<td>30BA550X</td>
<td>70 Alpine Park</td>
<td>Lexington</td>
<td>KY</td>
<td>42071</td>
</tr>
<tr>
<td>13C573CV</td>
<td>100 2nd Pass</td>
<td>North Las Vegas</td>
<td>NV</td>
<td>89148</td>
</tr>
<tr>
<td>340B4A8Y</td>
<td>70 Bonner Junction</td>
<td>New York City</td>
<td>NY</td>
<td>11234</td>
</tr>
<tr>
<td>3A90633B</td>
<td>30 Cottonwood Trail</td>
<td>Rockville</td>
<td>MD</td>
<td>20747</td>
</tr>
<tr>
<td>301AJ9944</td>
<td>8 Knudsen Court</td>
<td>Brooklyn</td>
<td>NY</td>
<td>10573</td>
</tr>
<tr>
<td>301AJ9944</td>
<td>90 Brown Way</td>
<td>Denver</td>
<td>CO</td>
<td>80126</td>
</tr>
<tr>
<td>322E53ED</td>
<td>60 Blue Hill Park Drive</td>
<td>Atlanta</td>
<td>GA</td>
<td>30328</td>
</tr>
<tr>
<td>3068068D</td>
<td>40 Cardinal Junction</td>
<td>Belfast</td>
<td>Northern Ireland</td>
<td>SN101DE</td>
</tr>
<tr>
<td>315708C1</td>
<td>10 Buena Vista Crossing</td>
<td>San Jose</td>
<td>CA</td>
<td>95626</td>
</tr>
<tr>
<td>305708C1</td>
<td>339 8th Junction</td>
<td>Trenton</td>
<td>NJ</td>
<td>08070</td>
</tr>
<tr>
<td>3098001E</td>
<td>0380 Pleasure Way</td>
<td>Boston</td>
<td>Massachusetts</td>
<td>02186</td>
</tr>
<tr>
<td>3099001E</td>
<td>90 Comanche Parkway</td>
<td>Los Angeles</td>
<td>CA</td>
<td>91754</td>
</tr>
<tr>
<td>3707A40L</td>
<td>2 Bunker Hill Hill</td>
<td>Jersey City</td>
<td>NJ</td>
<td>07017</td>
</tr>
<tr>
<td>31B5587F</td>
<td>70 Lakewood Place</td>
<td>Kalamazoo</td>
<td>MI</td>
<td>49201</td>
</tr>
<tr>
<td>3107A93U</td>
<td>80 Dexter Point</td>
<td>Ipoh</td>
<td>Perak</td>
<td>47300</td>
</tr>
<tr>
<td>13C5792CZ</td>
<td>600 Farmco Drive</td>
<td>Odessa</td>
<td>TX</td>
<td>78201</td>
</tr>
<tr>
<td>311079DM</td>
<td>80 Esker Drive</td>
<td>Whittier</td>
<td>BC</td>
<td>V6V4H5</td>
</tr>
<tr>
<td>31A5971F</td>
<td>20 Forest Junction</td>
<td>Hyattsville</td>
<td>MD</td>
<td>20617</td>
</tr>
</tbody>
</table>

6. **Close** the **New report** results window.

**Deleting** a column (via keyboard or icon) removes the column from the report page and the data item from the query.

**Cutting** a column by clicking the **Cut** icon removes the column from the report, but leaves the data item in the query. **Use Cut** for those times when you need to leave an item in the query, but do not want to see it on the report page.

**Rearranging Columns**

After running a report (or viewing the query), it is easy for the user to change the way the columns appear in the report. In this exercise, we will practice rearranging columns.

1. Return to the report page.
2. Under the **Report** tab double click on the Page1 button.
3. Click the EmplID column body or header to select it.
4. Drag the selected EmplID column heading to the end of the report, after Home Address Postal Code. Release when you see the blinking one lane highway. If the tool is finicky you can always cut and past the column.

5. Run the report to view the new report layout.
7. Save the report.

Adding a Column
Increasing the information in a report is easily accomplished by adding new columns to the report. There are several ways to add columns to a report.

- Double-clicking on the item
- Right-clicking on the item and choosing Insert
- Clicking and dragging the item to the report

1. From the Insertable objects window click the Sources icon.

Select the field to the right of where you would like the field to appear:

2. Select the Home Street Address column heading.
3. Right-click the Gender field and click Insert.

The Gender field will be inserted as the first column in the report.
4. **Click Run.**

5. **Close the New report results window.**

6. **Save the report.**

**Singletons**

You can insert a single data item anywhere in your report using the **Singleton** object from the Toolbox tab. The singleton object retrieves only the first row value for that query.

Inserting a single data item is useful when you want to show a value that is independent from the rest of the values in the report.

**Singletons** are inserted accidentally when dragging data items into our reports. To delete select the **Singleton** and **Delete** or select the **Undo** button to remove the last action.
1. Navigate to **Team Content > Training Data - Reports > Cognos Analytics Class Reports > Exercise 1: Personal Data Report.**

2. Click on the **Edit** button, in the orange toolbar.

3. Check that you are in **Page design** view.

    **Hint:** go to the **Page views** icon in the orange toolbar.

4. In your **My Content** area **Save** the report as **“Exercise 1: Personal Data Report”**.

5. Delete the **Middle Name** Column.

    **Hint:** Select the column header and use the **Delete** button or open to the **More** button drop down menu from the white contextual toolbar, and select **Delete** at the bottom.

6. Add the **Birthdate** field and make it appear as the **second column** of the report.

    **Hint:** select the column header immediately to the right of where you want to insert Birthdate.

    Right click on **Birth Date** and select **Insert**.

7. Add the two hidden fields (**Last Name** and **First Name**) back into the report from the **Data items** tab, as columns 2 and 3. **Hint:** The **Data items** tab is between the **Sources** and **Toolbox** tab.

8. Remove the Sort on **Last Name**.

9. Instead, sort **Ascending on Birthdate**.

    **Hint:** Select the **Birthdate** column header, then select **Sort Ascending** from the contextual toolbar.

10. Hide the **Birthdate** column.

    **Hint:** go the the **More** drop-down menu to find **Cut**.

11. **Run** the report.

12. **Close** the **New Report** window. **Save** your report.
Grouping and Aggregation

Grouping a List Report

If a column in a report contains multiple instances of the same value, you can group these identical values together. Grouping reorders the rows of a selected report item so that identical values appear together and the display of duplicates is suppressed.

Grouping (and/or ungrouping) might change the order of the report items as grouped columns precede ungrouped columns. However, you can reorder the list columns to make the report more readable.

Grouping columns of data makes it easier to find data, as all like items are within the same grouping. After grouping data, the columns can have a count, total, average, or similar function applied to them.

In this exercise, we’ll group columns to organize all of the records returned by Home Country.

1. Open the Personal Bio Info Report for editing. Select the More button next to the report name and in the menu select Edit report.
2. Save the report as Personal Data Report – Grouped.
3. Add the Home Address Country field to the report.
4. Move the Home Address Country field (column) to the beginning of the report so that the Home Address Country and Home Address State columns appear in the first and second column.
5. Save the report. Run the report.
6. Identify repeating data within the report. There are many rows with Home Address Country = USA.

<table>
<thead>
<tr>
<th>Home Address Country</th>
<th>Home Address State</th>
<th>Home Address Street</th>
<th>Home Address City</th>
<th>Home Address Postal Code</th>
<th>EmpID</th>
</tr>
</thead>
<tbody>
<tr>
<td>USA</td>
<td>VA</td>
<td>40th St Rd</td>
<td>Reston</td>
<td>22101</td>
<td>304C5995</td>
</tr>
<tr>
<td>USA</td>
<td>PA</td>
<td>60 Almo Circle</td>
<td>New Castle</td>
<td>19041</td>
<td>300787A1</td>
</tr>
<tr>
<td>USA</td>
<td>KY</td>
<td>70 Alpine Park</td>
<td>Lexington</td>
<td>42071</td>
<td>308A550X</td>
</tr>
<tr>
<td>USA</td>
<td>NY</td>
<td>100 2nd Pase</td>
<td>North Las Vegas</td>
<td>89148</td>
<td>13C573CV</td>
</tr>
<tr>
<td>USA</td>
<td>NY</td>
<td>70 Bonner Junction</td>
<td>New York City</td>
<td>11234</td>
<td>34084A8Y</td>
</tr>
<tr>
<td>USA</td>
<td>MD</td>
<td>30 Cottonwood Trail</td>
<td>Rockville</td>
<td>20477</td>
<td>3A0633B</td>
</tr>
<tr>
<td>USA</td>
<td>CA</td>
<td>90 Comanche Parkway</td>
<td>Los Angeles</td>
<td>91754</td>
<td>3008001E</td>
</tr>
<tr>
<td>USA</td>
<td>CO</td>
<td>90 Brown Way</td>
<td>Denver</td>
<td>80126</td>
<td>301A9944</td>
</tr>
<tr>
<td>USA</td>
<td>GA</td>
<td>60 Blue Hill Park Drive</td>
<td>Atlanta</td>
<td>30328</td>
<td>31EE8EQ</td>
</tr>
<tr>
<td>USA</td>
<td>Massachusetts</td>
<td>0380 Pleasant Way</td>
<td>Boston</td>
<td>02106</td>
<td>3098001E</td>
</tr>
<tr>
<td>USA</td>
<td>NJ</td>
<td>10 Buena Viola Crossing</td>
<td>San Jose</td>
<td>95626</td>
<td>30570C1</td>
</tr>
<tr>
<td>USA</td>
<td>NJ</td>
<td>338 8th Junction</td>
<td>Trenton</td>
<td>09670</td>
<td>30570C1</td>
</tr>
<tr>
<td>USA</td>
<td>NY</td>
<td>8 Knutson Court</td>
<td>Brooklyn</td>
<td>10573</td>
<td>301A9944</td>
</tr>
<tr>
<td>GBR</td>
<td>Northern Ireland</td>
<td>40 Cardinal Junction</td>
<td>Belfast</td>
<td>SN101DE</td>
<td>306990D</td>
</tr>
<tr>
<td>USA</td>
<td>NJ</td>
<td>2 Bunker Hill Hill</td>
<td>Jersey City</td>
<td>07017</td>
<td>3707A49L</td>
</tr>
<tr>
<td>USA</td>
<td>MI</td>
<td>70 Lakeswood Place</td>
<td>Kalamazoo</td>
<td>49201</td>
<td>31B5587F</td>
</tr>
<tr>
<td>MYS</td>
<td>Perek</td>
<td>80 Dexter Point</td>
<td>Ipoh</td>
<td>47200</td>
<td>31O793U</td>
</tr>
<tr>
<td>USA</td>
<td>TX</td>
<td>600 Farmco Drive</td>
<td>Odessa</td>
<td>73201</td>
<td>13C575CZ</td>
</tr>
<tr>
<td>CAN</td>
<td>BC</td>
<td>80 Esker Drive</td>
<td>Whistler</td>
<td>V6V4H5</td>
<td>311079DM</td>
</tr>
<tr>
<td>USA</td>
<td>MD</td>
<td>20 Forest Junction</td>
<td>Hyattsville</td>
<td>20617</td>
<td>31A5971F</td>
</tr>
</tbody>
</table>

8. Click once on the Home Address Country column header.
9. From the contextual toolbar, click the **Group/Ungroup** Icon.

![Image of Group/Ungroup icon]

The **Group** icon appears in the list column body.

10. Run the report. Notice that the **Home Address Country** is now grouped alphabetically ascending.

11. From the bottom of the window, click the button that says **Bottom** to jump to the end of the report.

The **USA** data is now being grouped by **Home Address Country**.

12. Close the **New report** results window.

13. Save your report.
14. Click the column heading of **Home Address State**.
15. Click the **Group/Ungroup** icon. Notice that the **Group** icon now appears in the column body.
16. Run the report.
17. Notice that the report is now grouping by **Country** and **State**.
   If there are no states in a country then the field is blank.
18. **Scroll down** through the report or use the **End** button on your keyboard to see to go to the last page. Notice that the USA States are grouped alphabetically ascending.

![](image)

<table>
<thead>
<tr>
<th>Country</th>
<th>Home Address State</th>
<th>Gender</th>
<th>Home Address Street</th>
<th>Home Address City</th>
<th>Home Address Postal Code</th>
<th>EmplID</th>
</tr>
</thead>
<tbody>
<tr>
<td>ANT</td>
<td></td>
<td>M</td>
<td>355 Quayside</td>
<td>Curacao</td>
<td>00000</td>
<td>39L4635J</td>
</tr>
<tr>
<td>ARE</td>
<td></td>
<td>F</td>
<td>15495 Wayridge Court</td>
<td>Umm al Qaywayn</td>
<td>313H111D</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>M</td>
<td>8 Crest Line Lane</td>
<td>Dubai</td>
<td>65004U18</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>F</td>
<td>90 Columbus Center</td>
<td>Al Fujayrah</td>
<td>7X8X300H</td>
<td></td>
</tr>
<tr>
<td>AUS</td>
<td>ACT</td>
<td>F</td>
<td>87 Quayside Vista</td>
<td>Canberra</td>
<td>2071</td>
<td>13C577C6</td>
</tr>
<tr>
<td></td>
<td></td>
<td>F</td>
<td>87 Quayside Vista</td>
<td>Canberra</td>
<td>2071</td>
<td>6X65E0X9</td>
</tr>
<tr>
<td>NTE</td>
<td>M</td>
<td>65 Ross Smith Avenue</td>
<td>Darwin</td>
<td>6015</td>
<td>51016R2Q</td>
<td></td>
</tr>
<tr>
<td>TSM</td>
<td>M</td>
<td>48 Barnett Street</td>
<td>Ridgeley</td>
<td>4218</td>
<td>475K947A</td>
<td></td>
</tr>
<tr>
<td></td>
<td>F</td>
<td>67 Springhill Bottom Road</td>
<td>Perth</td>
<td>2065</td>
<td>5101S61M</td>
<td></td>
</tr>
<tr>
<td>AUT</td>
<td>Kaernten</td>
<td>M</td>
<td>93916 Springs Parkway</td>
<td>Villeach</td>
<td>1150</td>
<td>K0502422</td>
</tr>
<tr>
<td></td>
<td>Oberoesterreich</td>
<td>M</td>
<td>6 Sauthoff Drive</td>
<td>Niederwaldkirchen</td>
<td>2560</td>
<td>51093R3B</td>
</tr>
<tr>
<td></td>
<td></td>
<td>F</td>
<td>99 6th Junction</td>
<td>Niederwaldkirchen</td>
<td>1030</td>
<td>4302710U</td>
</tr>
<tr>
<td>BGD</td>
<td>F</td>
<td>26266 Lindbergh Junction</td>
<td>Tungipra</td>
<td>1212</td>
<td>36833SHF</td>
<td></td>
</tr>
<tr>
<td>BGR</td>
<td>M</td>
<td>170 Sauthoff Center</td>
<td>Rila</td>
<td>1510</td>
<td>34G6606</td>
<td></td>
</tr>
<tr>
<td></td>
<td>M</td>
<td>42 Eagle Crest Street</td>
<td>Blagoevgrad</td>
<td>8000</td>
<td>41029MMV</td>
<td></td>
</tr>
</tbody>
</table>

19. **Close** the **New report results window**.
20. **Save** the report.
21. Click the **Home** button.
**Level Spanning**

Level Spanning controls how often the user chooses to show a particular item within a group. It is helpful to group all like records together and have each record's information appear on each line.

Let's start a new report for this exercise.

1. Click the **New** button to start a new report.
2. Choose the **01 - Princeton List** template.
3. Navigate to the Training Data Package:
   - **Team Content > Training Data Reports > Training Data Cognos Package > Training Data**
4. Expand the **Student Class Data** query subject found under the **Student Data** query subject.
5. Add the below data items to your report:
   - EmplID
   - Academic Career
   - Academic Program
   - Academic Dept

6. Save the report as **Level Spanning My Content**.
7. Run the report.
8. Notice that there is lots of duplication in the Academic Career, Academic Program and Academic Dept fields.
9. Close the **New report** results window.

10. **Group** the last three columns together.
    **Hint:** Control+click to select all 3 column headers. The **Group** icon is in the contextual toolbar above the columns.
11. Notice that the **Group** icon is now added to all 3 column lists.
12. Save the report.
13. **Run the report.**

If you scroll down a few pages, notice that when the Academic Dept changes, the Academic Program does not show next to the new Academic Dept.

The records are now grouped – first by Academic Career, then by Academic Program, and next by Academic Department.

14. **Close the New report results window.**

In order for the Academic Program to be listed next to each Academic Department the Level Span association must be made.

15. **Highlight the Academic Program column body and go to the Properties window Data section.**

16. Under the Data section, click Group Span to activate the drop-down menu button.

17. Click the drop-down arrow.

18. Select Academic Dept from the list.
19. **Run** the report.
20. **Page down** and notice that each time the **Academic Dept** changes, the **Academic Program** now shows next to the new **Academic Dept**.
21. **Close** the **New report** results window.
22. **Save** the report.

### Sections

Sections are similar to groupings. A section differs in that it shows the query item as the heading of a section or area within the report.

In this exercise, we’ll create a **Section** based on **Academic Career**.

1. **Save** this report in **My Content** as **Sections**.
   
   We will need to undo the Level Spanning property done in the previous exercise.

2. **Highlight** the **Academic Program Column Body** and locate **Group Span** under **Data** in the **Properties** pane.

3. Click the drop-down arrow to reveal a list of query items (other grouped fields) and choose **Academic Career**. Notice that the **Academic Program Column Body** formatting changes.

   You may also get a message indicating that the report was updated and validated. Select **OK**.
4. Highlight the **Academic Career** column heading.
5. From the contextual toolbar, next to the **Group/Ungroup** icon, open the **Section/Unsection** drop-down menu and select **Section/unsection**.

Notice the **Academic Career** field now appears above the other data item column headers.

Click the 3 Dots at the very top/left corner of the report above **Academic Career** to select the entire table.

6. In the **Properties** window go to **Data, Rows per page**.
7. Next to **Rows Per Page**, enter **100**. This will allow us to see more rows in the window when we run the report to **HTML**.
8. Run the report to **HTML**.
9. Identify the **Academic Career** query item section breaks.
10. Use the **Page down** button at the bottom of the report page to move through the report until you see the **Academic Career** change from **GR** to **UG**.
11. Close the **New report** results window.
12. Save the report.
**Page Breaks**

Report pages can be separated on designated grouped fields.

In order for Cognos Analytics to insert a page break for fields, a field must be grouped or sectioned.

1. Save the report as **Page Breaks**.
2. From the **Report** tab, click on the **Pages** tab.
3. From the **Insertable objects** window, select **Page set** and drag it to the **Pages** section above **Page1**.

4. Drag **Page1** over the **Detail Pages**. **Page1** should appear below and to the right of the **Detail Pages** folder.

5. Click to select **Page Set1**.
6. Go to the **Page set Properties** window for the **Data** section.
7. Open the **Query** menu.
8. Select **Q_List1**.
9. From the **Page set Data** section in the **Properties** pane, click the **Grouping and sorting** property.
10. Click the **More** button to open the **Grouping & sorting** dialog box to help us group by **Academic Career**.

---

Content in this document is based on fictitious data sets represented in CeDAR’s Training Package.
11. From the **Data Items** section, drag **Academic Career** to **Overall** in the **Groups** section. The **Groups** sort order should look like the screen shot.

12. Click **OK**.

13. **Run** the report to PDF.

14. Scroll down to page 13. You will notice that **Academic Career: GR** ends mid-page, and **Academic Career: UG** begins on Page 14. At the end of each **Academic Career**, you will now go to the next page to view the next **Academic Career** group.

15. **Close** the **New report** results window.

16. **Save** the report.
Create a new list report from the Person Data Query Subject that uses the below data items:

- EmplID
- Last Name
- First Name
- Home Address Street
- Home Address City
- Home Address State
- Home Address Postal Code
- Home Address Country

Then:

1. Group the report by Home Address Country.
2. Sort by Last Name in Ascending order.
4. Save the report in My Content as “Grouping Exercise”.

<table>
<thead>
<tr>
<th>EmplID</th>
<th>Last Name</th>
<th>First Name</th>
<th>Home Address Street</th>
<th>Home Address City</th>
<th>Home Address State</th>
<th>Home Address Postal Code</th>
<th>Home Address Country</th>
</tr>
</thead>
<tbody>
<tr>
<td>36L4635J</td>
<td>Honore</td>
<td>Viraj</td>
<td>355 Quayside</td>
<td>Curacao</td>
<td></td>
<td></td>
<td>ANT</td>
</tr>
<tr>
<td>313H111D</td>
<td>Cochran</td>
<td>Amanda</td>
<td>15485 Wayridge Court</td>
<td>Umm al Qaywayan</td>
<td></td>
<td></td>
<td>ARE</td>
</tr>
<tr>
<td>65004U18</td>
<td>Scott</td>
<td>Luke</td>
<td>8 Crest Line Lane</td>
<td>Dubai</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7X8X300H</td>
<td>Vattis</td>
<td>Akaylia</td>
<td>90 Columbus Center</td>
<td>Al Fajrah</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13C577C6</td>
<td>Ambelioti</td>
<td>Roseanne</td>
<td>87 Quayside Vista</td>
<td>Canberra</td>
<td>ACT</td>
<td>2071</td>
<td>AUS</td>
</tr>
<tr>
<td>475K947A</td>
<td>Lind</td>
<td>Dilum</td>
<td>48 Barnett Street</td>
<td>Ridgeley</td>
<td>TSM</td>
<td>4218</td>
<td></td>
</tr>
<tr>
<td>50161B2Q</td>
<td>Pannell</td>
<td>Mohammed</td>
<td>55 Ross Smith Avenue</td>
<td>Darwin</td>
<td>NTW</td>
<td>9015</td>
<td></td>
</tr>
<tr>
<td>5013S61M</td>
<td>Patania</td>
<td>Paschalia</td>
<td>87 Springhill Bottom Road</td>
<td>Perth</td>
<td>TSM</td>
<td>2065</td>
<td></td>
</tr>
<tr>
<td>6X8G60X9</td>
<td>Tamrakar</td>
<td>Karas</td>
<td>87 Quayside Vista</td>
<td>Canberra</td>
<td>ACT</td>
<td>2071</td>
<td></td>
</tr>
<tr>
<td>51093R3B</td>
<td>Nahata</td>
<td>Yinnai</td>
<td>6 Sauthoff Drive</td>
<td>Niedervolkirchen</td>
<td>Oberosterreich</td>
<td>2560</td>
<td>AUT</td>
</tr>
<tr>
<td>K0902422</td>
<td>Wei</td>
<td>Jonathann</td>
<td>93915 Springs Parkway</td>
<td>Villach</td>
<td>Kaernten</td>
<td>1150</td>
<td></td>
</tr>
<tr>
<td>4302710U</td>
<td>Youngas</td>
<td>Charu</td>
<td>99 6th Junction</td>
<td>Niedervolkirchen</td>
<td>Oberosterreich</td>
<td>1030</td>
<td></td>
</tr>
<tr>
<td>3683353F</td>
<td>Franklin</td>
<td>Rona</td>
<td>25266 Lindbergh Junction</td>
<td>Tungiporea</td>
<td></td>
<td>1212</td>
<td>BGD</td>
</tr>
<tr>
<td>345G6608</td>
<td>Cooper</td>
<td>Nithish</td>
<td>170 Sauthoff Center</td>
<td>Rila</td>
<td></td>
<td>1510</td>
<td>BGR</td>
</tr>
<tr>
<td>41029MMV</td>
<td>Khan</td>
<td>Abuzar</td>
<td>42 Eagle Crest Street</td>
<td>Blagoevgrad</td>
<td></td>
<td>8000</td>
<td></td>
</tr>
<tr>
<td>478682G5</td>
<td>Arbuckie</td>
<td>Diana</td>
<td>010 Warbler Lane</td>
<td>Blagaj</td>
<td></td>
<td>74000</td>
<td>BIH</td>
</tr>
<tr>
<td>311E7E14</td>
<td>Avery</td>
<td>Amanda</td>
<td>010 Warbler Lane</td>
<td>Blagaj</td>
<td></td>
<td>74000</td>
<td></td>
</tr>
<tr>
<td>0920633F</td>
<td>Wilton</td>
<td>Annila</td>
<td>95878 Larry Crossing</td>
<td>Glamoc</td>
<td></td>
<td>88000</td>
<td></td>
</tr>
<tr>
<td>31076D6F</td>
<td>Atchison</td>
<td>Molly</td>
<td>025 Milwaukee Lane</td>
<td>Ponta Portal</td>
<td></td>
<td>12243830</td>
<td>BRA</td>
</tr>
<tr>
<td>3828610F</td>
<td>Eliasen</td>
<td>Seeyuen</td>
<td>2224 Boshford Hill</td>
<td>Sao Lourenco</td>
<td></td>
<td>78200000</td>
<td></td>
</tr>
</tbody>
</table>
Calculations

Simple, complex and macro calculations are possible within Cognos Analytics. This chapter will introduce you to basic calculations.

We can create a calculated column by multiplying one column with another. Grouping a column allows you to keep all the similar data together, and to add summaries for each group. Some of the summaries available are counts, averages, and totals. For example, you can count the number of rows, show the average numbers in a group, and show group totals.

In this exercise, we'll build a report we will use in the rest of this chapter.

1. Click the New button to create a new report.
2. Choose the Princeton List Template.
3. Open the Training Data Package.
4. From the Person Data Query Subject, pull over the following Query Items:
   - Last Name
   - Middle Name
   - First Name
   - Birth Date
5. You may control-click to select several items at a time. The order in which you select the items is the order in which they will populate the columns from left to right.
6. Save the report in My Content as Calcs.

Adding a Calculated Column

A calculated column is a column created by the user that does not currently exist in the model.

We will create a new calculated column for Age using the existing Birthdate field. We will calculate a person's age using the existing Birth Date field from the model and an SQL function in a new field named “Age”.

1. From the Insertable objects section, click the Toolbox tab.
2. Open the Textual section.
3. Select Query Calculation and drag it to the right of the Birth Date.
   Release when you see the blinking one lane highway.

<table>
<thead>
<tr>
<th>Last Name</th>
<th>Middle Name</th>
<th>First Name</th>
<th>Birth Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alcala</td>
<td>Hoju</td>
<td>Un</td>
<td>May 21, 1991 12:00:00 AM</td>
</tr>
<tr>
<td>Baylies</td>
<td>Per</td>
<td></td>
<td>Apr 23, 1993 12:00:00 AM</td>
</tr>
<tr>
<td>Beeman</td>
<td>Alaina</td>
<td>Chona</td>
<td>Mar 19, 1993 12:00:00 AM</td>
</tr>
<tr>
<td>Bell</td>
<td>Paul</td>
<td></td>
<td>Nov 24, 1992 12:00:00 AM</td>
</tr>
<tr>
<td>Berry</td>
<td>Carol</td>
<td>Hannah</td>
<td>Dec 26, 1993 12:00:00 AM</td>
</tr>
<tr>
<td>Bertrand</td>
<td>Wei</td>
<td>Hoju</td>
<td>Dec 4, 1991 12:00:00 AM</td>
</tr>
<tr>
<td>Colucci</td>
<td>Xiaoliang</td>
<td></td>
<td>Jun 30, 1993 12:00:00 AM</td>
</tr>
<tr>
<td>Banerji</td>
<td>Jatna</td>
<td></td>
<td>May 5, 1992 12:00:00 AM</td>
</tr>
<tr>
<td>Chamberlin</td>
<td>Yosif</td>
<td>Raffael</td>
<td>Apr 18, 1993 12:00:00 AM</td>
</tr>
</tbody>
</table>
4. The **Data item expression** window opens.
5. In the **Name** field type **Age**.
6. Select the **Functions** tab and open the **Business Date/Time Functions** folder.

![Image](image1.png)

7. Scroll down to find **_years_between**.
8. Double-click on **_years_between** or drag it into the **Expressions Definition** window on the right.
9. Open the **Common Functions** folder and then open the folder **A-C**.
10. Double-click the **current_date** function to add it to the **Expressions Definition** window on the right.
11. Type a **comma** and a **space** after **current_date** to separate functions.
12. Click the **Source** or **Data Items Tab** and locate **Birth Date**.
13. Double-click **Birth Date** to add it to the Expression Definition area on the right.
14. Type a closed parenthesis **)** after **Birth Date**.
15. Click the **Validate** button to ensure there are no errors with your calculation.
16. Click **OK**.

**Note:** If you take **Birth Date** from the **Source** data you will see the qualified name of the data item in the expression, i.e. **_years_between (current_date, [Fictitious Training Data].[Person Data].[Birth Date])**.

If you take **Birth Date** from the **Data Items** in the report you will just see the **Data** item in the expression.

**Expression Definition:**

**_years_between (current_date, [Birth Date])**

![Image](image2.png)
17. **Run** the report. 
   The **Age** column shows the calculated age values. 
18. **Close** the Report Results window. 
19. Click **Save**.

### Understanding Aggregation
Aggregation is the summarization of grouped items. Cognos Analytics automatically groups non-numeric data (text or date) and summarizes numeric data. The numbers you see in your reports are probably a summarization of the raw data from the database.

The user can turn this default automatic aggregation off at the report level.

1. Select the **Q_List1** query from the **Report** pull-down menu. 
2. The **Properties** pane is on the far right. 
3. Under **Data** go to **Auto group and summarize**. 
4. The default value is **Yes**. Set the value to **No**.

### Types of Aggregation:

Some of the common types of aggregation are:

- **Total**: Sums the items in the group
- **Average**: Averages the items in the group
- **Minimum**: Shows the smallest number in the group
- **Maximum**: Shows the largest number in the group
- **Count**: Counts the number of items in the group

The default type of aggregation for each numeric data item is set in the package.

### Totaling a Column - Adding Summary Totals to a Footer

You can also create additional aggregates within the report. You can group the report and add summaries to the group footers.

An ungrouped report will show counts, totals, etc. for the entire report. If the report is grouped, and then counts, totals, etc., are added, the report will show the summaries for each individual group and for the report as a whole.

This exercise will total the **EmplIDs** for the entire report.

1. Create a **new list report** using **Student Class Data** in the **Student Data** query subject with the below fields:
   - Academic Program Descr
   - Academic Track
   - EmplID

2. **Save** the Report in **My Content** as **Calculated ID List**. 
3. **Highlight** the **EmplID** List Column Body.
4. In the Properties pane, scroll way down to the Data Item section and set the Detail Aggregation to Count.
5. Run the report.

The EmplIDs are counting the number of students in each Academic Track.

7. Click the EmplID List Column Header.
8. In the contextual toolbar, click the drop-down arrow to the right of the Summarize icon and choose Calculated.
The design view changes to show the Calculated row has been added to our report.

10. At the bottom of the report is the “Overall Calculated” Footer.
11. The number of EmplIDs for the entire report is shown in the last row.


Note that the numbers do not show thousands separators.

Formatting Numbers
We can make changes to numbers in the Data format window. Let’s show the thousands separators.

1. Highlight the EmplID column body and control-click to also highlight the Calculated(EmplID) field.
2. Select the Data format icon.
3. When the Data format window opens select Number under Format type.
4. In the Properties window change the Use thousands separator setting to Yes.
5. Select OK.
6. Run the report.
   The thousands separators now appear.
7. Close the New report results window.
8. Save the report.
Remove the Summary Footer
Save the report as Calculated ID List – Grouped Summary

To remove the summary footer:

1. Select the Overall - Calculated footer at the bottom of the report.
2. Select the Delete key at the bottom of the More drop-down menu.

The summary footer and the EmplID count are deleted from the report.

3. Save the report.

Grouped Summary Footers
In this exercise, we’ll perform counts by Academic Track and counts for each Academic Program and a Summary count for all EmplIDs.

1. Use the Calculated ID List – Grouped Summary report.
2. Group the Academic Program Description and then the Academic Track fields.
   Select one column field at a time and click once on the Group/Ungroup button.
3. Highlight the EmplID List Column Body.
4. In the Properties pane, Data Item section, set the Detail Aggregation to Count (if it is not already set).
5. Highlight the EmplID Column Header.
6. From the contextual menu, click the drop-down menu to the right of the Summarize icon and choose Calculated.

The Overall Calculated footer is added to the report.

7. Run the report.
8. When ready close the New report results window and return to the report page.
Format the EmplID column

1. Highlight all the EmplID fields under the column header and format the number with a thousands separator by opening the **Data format** icon in the contextual toolbar.
2. Run the report.
3. When ready close the **New report** results window.

<table>
<thead>
<tr>
<th>Academic Program Descr</th>
<th>Academic Track</th>
<th>EmplID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bachelor of Arts</td>
<td>Architecture</td>
<td>7,713</td>
</tr>
<tr>
<td></td>
<td>Education</td>
<td>7,074</td>
</tr>
<tr>
<td></td>
<td>Language and Human Development</td>
<td>15,373</td>
</tr>
<tr>
<td>Bachelor of Arts - Calculated</td>
<td></td>
<td>30,160</td>
</tr>
<tr>
<td>Bachelor of Science</td>
<td>Agriculture and Life Sciences</td>
<td>10,984</td>
</tr>
<tr>
<td></td>
<td>Engineering</td>
<td>5,480</td>
</tr>
<tr>
<td></td>
<td>Government and Politics</td>
<td>8,272</td>
</tr>
<tr>
<td>Bachelor of Science - Calculated</td>
<td></td>
<td>24,736</td>
</tr>
<tr>
<td>Masters of Medical Sciences</td>
<td>Graduate School of Medical Sciences</td>
<td>6,552</td>
</tr>
<tr>
<td>Masters of Medical Sciences - Calculated</td>
<td></td>
<td>6,552</td>
</tr>
<tr>
<td>Veterinary Science</td>
<td>Agriculture and Life Sciences</td>
<td>2,624</td>
</tr>
<tr>
<td></td>
<td>Veterinary Medicine</td>
<td>712</td>
</tr>
<tr>
<td>Veterinary Science - Calculated</td>
<td></td>
<td>3,336</td>
</tr>
<tr>
<td>Overall - Calculated</td>
<td></td>
<td>64,784</td>
</tr>
</tbody>
</table>

Adjust the Alignment

Let’s adjust the number alignment in the EmplID column.

1. Highlight all the EmplID fields under the column header.
2. In the contextual toolbar open the **Horizontal alignment** icon to the right of the **Data format** icon.
3. Set the **Horizontal alignment** to right justify.
4. Run the report.
   Notice that the numbers are now right justified.
5. When ready close the **New report** results window and return to the report page.
6. **Save** the report.

<table>
<thead>
<tr>
<th>Academic Program Descr</th>
<th>Academic Track</th>
<th>EmplID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bachelor of Arts</td>
<td>Architecture</td>
<td>7,713</td>
</tr>
<tr>
<td></td>
<td>Education</td>
<td>7,074</td>
</tr>
<tr>
<td></td>
<td>Language and Human Development</td>
<td>15,373</td>
</tr>
<tr>
<td>Bachelor of Arts - Calculated</td>
<td></td>
<td>30,160</td>
</tr>
<tr>
<td>Bachelor of Science</td>
<td>Agriculture and Life Sciences</td>
<td>10,984</td>
</tr>
<tr>
<td></td>
<td>Engineering</td>
<td>5,480</td>
</tr>
<tr>
<td></td>
<td>Government and Politics</td>
<td>8,272</td>
</tr>
<tr>
<td>Bachelor of Science - Calculated</td>
<td></td>
<td>24,736</td>
</tr>
<tr>
<td>Masters of Medical Sciences</td>
<td>Graduate School of Medical Sciences</td>
<td>6,552</td>
</tr>
<tr>
<td>Masters of Medical Sciences - Calculated</td>
<td></td>
<td>6,552</td>
</tr>
<tr>
<td>Veterinary Science</td>
<td>Agriculture and Life Sciences</td>
<td>2,624</td>
</tr>
<tr>
<td></td>
<td>Veterinary Medicine</td>
<td>712</td>
</tr>
<tr>
<td>Veterinary Science - Calculated</td>
<td></td>
<td>3,336</td>
</tr>
<tr>
<td>Overall - Calculated</td>
<td></td>
<td>64,784</td>
</tr>
</tbody>
</table>

Rename the Academic Program Column Header

Let’s rename the Academic Program label.

1. Highlight the Academic Program column header.
2. Go to **Properties > Data Item** and add **Academic Program** to **Label**.
3. Run the report.
4. Close the **New report** results window.
5. **Save** the report.
Auto Group and Summary
The automatic group and summary feature is unchecked in this version of Cognos 11.1.3. If you want this feature turned on for all list reports you can activate this feature.
Go to edit mode in a report. **Do not make the actual change to settings at this time.**

- Click the **Cog More** button next to the page view in the upper right toolbar.
- Select **Options** at the bottom of the pull-down menu.
- Click the **Report** tab in the **Options** window.

- **Check** the box next to **Automatic group and summary behavior for lists**.
- Click **OK** to accept this change. **Do not make the actual change to settings at this time.**
Summary Calculation without Academic Program Details

You may wish to show aggregate data without showing the detail. We will create a column that shows only the count of EmplIDs without showing the actual EmplID numbers by creating a summary calculated column.

1. Open the original Calculated ID List to edit the report.
2. Save the report as Academic Program Summary no Details.
3. Check that you are in Edit mode. When you hover over the Edit button there will be a black line under it.
4. Select the Overall-Calculated footer and go into the More drop-down menu to Delete it, or use the Cut button in the contextual toolbar.
5. Save the report.
6. Group the Academic Program Description and the Academic Track columns.
7. Highlight the EmplID list column body.
8. Go to the Properties > Data Item section.
9. Change Detail aggregation to None.
10. Run the report. Notice that the individual EmplIDs show within each Academic Program and Academic Track.
11. Close the New report results window.
12. Save your report.
13. Click the EmplID list body column.
14. In the Properties pane, scroll to the Data Item section.
15. Click the drop-down arrow next to Detail aggregation and select Count.
16. Select the EmplID Column Heading.
17. In the Properties pane, scroll up to the Text Source section.
18. From the Source Type field, click the drop-down arrow and select Text.
19. The table will update and the EmplID field will prompt you to double-click to edit text in the header.

20. The Text window opens.
21. Type “Count of IDs”.
22. Click OK.
23. Run the report.

Instead of showing each individual EmplID, Cognos Analytics summarizes by counting the number of EmplID’s associated with each Academic Program Description and Academic Track.

25. Save the report.
COUNT VS COUNT DISTINCT

What’s the difference between these two functions?

Answer:

Using the following criteria: EMPLID, HOME ADDRESS STATE, HOME ADDRESS COUNTRY

- Based on the report criteria, the Count function returns the number of values in the column you specify to be counted.

Example: If you were doing a Count on EmplIDs (some having multiple addresses), Cognos would return a total number of EmplIDs for the entire database, counting some EmplIDs more than once.

- The Count Distinct function returns the number of unique values in the column you specify to be counted.

Example: If you wanted Cognos to return the number of unique EmplIDs (multiple addresses may be associated with some EmplIDs), you would use the Count Distinct function on EmplID.
Try it!

1. Create a **new/blank** report.
2. Open the Training Package and expand the **Person Data** Query Subject.
3. Drag **EmplID**, **Home Address State**, and **Home Address Country** into the report.
4. Sort **EmplID** in **Ascending** order.
5. Perform a **Count** function on **EmplID**.
   Hint: use the **Summary** pull-down in the contextual toolbar.
7. To view the Overall-Count, click the **Bottom** link to get to the end of the report.

Notice the overall count for EmplIDs is **2166**.

8. Close the **New report** results window.

1. **Save** the report as **“Stretch Your Thinking – Count on EmplID”**
2. Select the **<Count(EmplID)>** row and press **Delete or Cut**.
3. **Save** as **Stretch Your Thinking – Count Distinct on EmplID**.
4. Now, perform a **Count Distinct** function on **EmplID**.
   Hint: use the **Summary** pull-down in the contextual toolbar.
5. **Run** the report.
6. To view the **Overall - Count distinct**, click the **Bottom** link to get to the end of the report.

Notice the **Overall - Count distinct** for EmplIDs is now **1775**.

1. Close the **New report** results window.
2. **Save** the Report.
Visualizations
A visualization is the presentation of data in a pictorial form. It can be a graph, map or other or other visual form. Visualizations enable users/decision makers to view data in a different way, so they can identify patterns or trends in the data.

Pie Chart
A pie chart is a circular statistical graphic, which is divided into slices to illustrate numerical proportion. It shows how parts make up and compare to a whole.

1. Create a new blank report.
2. Open the Training Package.
3. Click the in the middle of the content explorer.
4. Choose Visualization.

The visualization Gallery will open, prompting you to choose a visualization type.

5. Scroll down to choose Pie.
6. Click OK.
7. Expand the Courses and Classes query subject to view the Department query.
8. Ctrl + click Academic Program and Faculty Count and drag them into the pie.

Notice that Cognos has strategically placed your data items in the Tabular data set window. Academic Program is in the Segments area. Faculty Count appear in the Size area.
9. Click **Run**. Select **Run HTML**.

The faculty count for each Academic Program is displayed in 4 respective parts.

The **Academic Program** legend appears in the top right of the visualization.

10. In the **New report** results window, hover over each piece of the pie. A data window opens giving you additional information about that slice.

11. **Close** the **New Report** results window.

12. From the Application Toolbar, click the **Page design** pull-down menu and select **Page preview**. You can view report output without running the report.

13. **Save** the report in **My Content** as **Pie Chart**.
Clustered Bar Chart
Let’s create a Stacked Bar Chart.

1. Create a New blank report.
2. Choose the Training Data package.
3. Click the  in the middle of the report canvas.
4. Choose Visualization.
5. From the Visualization Gallery, scroll down to choose Clustered Bar Chart.
6. Navigate to Student Class Data in Student Data.
7. Drag Academic Career to Bars.
8. Drag Academic Program to Color.
10. Drag Financial Aid Award Requested to Length.
11. Run the report to HTML.
12. The New report window shows the Clustered Bar Chart.
13. If you hover over a bar a tooltip will open to give Financial Aid Award info by Academic Career.
15. Save the report in My Content as Financial Aid Requested by Academic Career.
Clustered Bar Chart
To use EmplID as a measure in a report you need to change the Detail Aggregation from None to Count.

When you’re trying to add an attribute (like EmplID) to a visualization (like a stacked bar chart), Cognos will identify an error with the data type.

Let’s create a Clustered Bar Chart and change EmplID to a measure to use it in our visualization. Our report will count EmplIDs by Term showing Fin Aid Award Amount Given.

1. Create a New blank report.
2. Choose the Training Data package. > Training Data – Reports > Training Data Cognos Package > Training Data
3. Click the + icon in the middle of the Content Explorer.
4. Choose Visualization.
5. When the Visualization gallery opens go over to the Visualizations window on the right and select the legacy 11.0 visualizations from the pull-down menu.

6. Select the Clustered Bar.

Double click on the Clustered Bar or select it and click OK.

7. When the Object and query names window opens name your visualization Financial Aid Awarded by Term. Select OK.
8. The **Clustered Bar** template opens.

9. Change your view from **Page design** to **Page preview** in the top right white toolbar.

10. Expand the **Student Data > Financial Aid** folder/query subject.
11. Drag **EmplID** to **X axis**.
12. Drag **Financial Aid Award Amount Given** to the **Value** area.
13. Drag **Term Code** to **Color**.

   Notice that the visualization appears with multiple **EmplIDs** that don’t provide useful information.

   We need to re-define the **EmplID** value as a **Measure**.

14. To do this we need to modify **Query1**.
Changing Values to Measures - EmplID as a Measure

1. From the Report tab select Query1.
2. In the Data Items box highlight EmplID.

3. In the Data Items Properties window change the Detail Aggregation to Count.
   You will need to scroll up in the menu.

5. Click on the visualization canvas to make it active.
6. Notice that the visualization is now counting all EmpID’s by term.
   When you hover over one of the single colored bars the tooltip tells you the **Count of EmpID**, the **Term Code**, and the **Total Financial Aid Award Amount Given** during that **Term**.
7. Run the report (or use **Page Preview**) to see the visualization.
8. Save the report in **My Content** as **Fin Aid Awarded by Term**.
Filters

Concepts
A filter reduces the amount of data in a report by the criteria you set. You can filter one or more items, by a precise match or by a partial match.

Expressions:
A filter expression includes:

- A column name, which can be taken from the report
- An operator, such as “=” or “<>”
- The data we are searching for

Example of Filter Expression:

\[
[Fictitious \text{ Training Data}].[Person \text{ Data}].[Last \text{ Name}] = 'Balboa'
\]

1. Namespace
   2. Query Subject
   3. Query Item
   4. Operator
   5. Value

The Operator indicates what kind of match is made. Below is a list of common operators:

= \quad \text{Equal to.} \quad \text{Must find a precise match.}

<> \quad \text{Not equal to.} \quad \text{Shows everything except the match.}

In \quad \text{Matches a list of items.}

Not In \quad \text{Shows everything except the matches.}

Starts With \quad \text{Retrieves everything that begins with the characters of the phrase.}

Contains \quad \text{Retrieves everything that contains the matching characters or phrase.}

Is Missing \quad \text{Retrieves blanks.}
Opening the Filters Dialog Window
Let’s take a look at and get familiar with the Filters dialog window.

Start a new List report.

1. Navigate to Training Data > Presentation Layer > Fictitious Training Data > Person Bio Data > Person Data.
2. From the Person Data Query Subject, bring the following fields into the report:
   - Last Name
   - First Name
   - Home Address Street
   - Home Address City
   - Home Address State
   - Home Address Postal Code
   - Home Address Country
   - Birth Date
3. Open Student Data > Student Class Data and add Academic Career to the report.
4. Save the report as Pre-Filter.

5. Select the entire table (click the three dots on the top left corner of the first field).
   Do not click on the three-dots in the top left of the Princeton label field.

6. From the contextual toolbar, click the Filters icon and choose Edit Filters.

Content in this document is based on fictitious data sets represented in CeDAR’s Training Package.
7. Explore the Filters Dialog window.

The Filters window consists of two tabs: Detail Filters and Summary Filters. Detail Filters apply to the rows in the report. Summary Filters apply to grouped (or aggregate) data in the report. Summary filters also apply to an item not in the package, such as a calculated item that has been created.

**The Usage Area**
- Consists of three options
  - Required: The filter is required. In the case of a prompt, the report will not run until you have made a choice from the prompt.
  - Optional: The filter is optional. In the case of a prompt, the report will run even if you do not choose anything from the prompt.
  - Disabled: The filter is disabled. Disabling a filter allows the report to run without applying the filter. The filter is not removed; it is deactivated which may help in trouble-shooting the report.

**The Application Area**
- Consists of two options
  - Before Aggregation: To apply a filter before a summary is calculated, non-aggregated records are filtered.
  - After Aggregation: To apply a filter after a summary is calculated, aggregated rows are filtered.

**Filter Expression Actions**
The following actions are available for the filter expression:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="+" alt="Add" /></td>
<td>Add: Use this icon to add a new filter.</td>
</tr>
<tr>
<td><img src="%E2%88%92" alt="Delete" /></td>
<td>Delete: Use this icon to delete an existing filter.</td>
</tr>
<tr>
<td><img src="-pencil" alt="Edit" /></td>
<td>Edit: Use this icon to edit an existing filter.</td>
</tr>
</tbody>
</table>
The Filters Dialog Window
- Check you are on the Detail Filters tab.
- From the filters window, bottom left, click the Add icon.
- The Create Filter window opens.
- Select Advanced.
- Click OK.

- The Detail filter expression window opens.

Detail Filter Expression
Let’s look at the different tabs across the bottom of the window:
The Source tab allows you to filter on any item in the package.

The Data items tab allows you to filter on items in the report.

The Queries tab allows you to filter on items from other queries in your report.

The Functions tab allows you to create filter calculations.

When building a filter, you can specify the data type. This is optional. If you already know the data that you are looking for you can type it directly into the expression box, provided you use the correct syntax.

Use the Constants folder to locate a list of available data types.

The Parameters tab allows you to use the input derived from users when they answer the parameter.

The Macros tab is used to insert a fragment of code in a statement of a query or expression.

For example, add a macro to insert a new data item containing a user’s name or netid. It is also used to test report output formats or to apply conditional formatting.

The Tips area provides you with background information for available components as well as an example of how to use that component.
Filtering on a Single Item from the Source Tab

Cognos Analytics provides the flexibility to either filter on an item in the model or on an item in the report. The Source tab is the location to use to filter on an item in the model.

1. **Cancel** out of the windows to get back to the report window.
2. **Run** the report to view it before any filters are applied.

<table>
<thead>
<tr>
<th>Last Name</th>
<th>First Name</th>
<th>Home Address Street</th>
<th>Home Address City</th>
<th>Home Address State</th>
<th>Home Address Postal Code</th>
<th>Home Address Country</th>
<th>Birth Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agarwal</td>
<td>Conney</td>
<td>98 Golf View Parkway</td>
<td>Buffalo</td>
<td>NY</td>
<td>14803</td>
<td>USA</td>
<td>Jan 29, 1993 12:00:00 AM</td>
</tr>
<tr>
<td>Bailey</td>
<td>Par</td>
<td>051 Lillian Center</td>
<td>Houston</td>
<td>TX</td>
<td>77336</td>
<td>USA</td>
<td>Apr 23, 1993 12:00:00 AM</td>
</tr>
<tr>
<td>Bell</td>
<td>Sam</td>
<td>0596 Ferragut Pass</td>
<td>Orlando</td>
<td>FL</td>
<td>34429</td>
<td>USA</td>
<td>Sep 10, 1591 12:00:00 AM</td>
</tr>
<tr>
<td>Bell</td>
<td>Paul</td>
<td>0596 Thompson Terrace</td>
<td>New York City</td>
<td>NY</td>
<td>10023</td>
<td>USA</td>
<td>Nov 24, 1992 12:00:00 AM</td>
</tr>
<tr>
<td>Carr</td>
<td>Tim</td>
<td>117 Twin Pines Point</td>
<td>Lancaster</td>
<td>PA</td>
<td>18901</td>
<td>USA</td>
<td>Jan 17, 1992 12:00:00 AM</td>
</tr>
<tr>
<td>Avery</td>
<td>Peter</td>
<td>023 Gooden Park</td>
<td>New York City</td>
<td>NY</td>
<td>11726</td>
<td>USA</td>
<td>Jul 29, 1992 12:00:00 AM</td>
</tr>
<tr>
<td>Sareenje</td>
<td>Edouard</td>
<td>047 4th Circle</td>
<td>Jacksonville</td>
<td>FL</td>
<td>33407</td>
<td>USA</td>
<td>May 6, 1991 12:00:00 AM</td>
</tr>
<tr>
<td>Colofatia</td>
<td>Guin Yoga</td>
<td>1670 Arizona Pass</td>
<td>New York City</td>
<td>NY</td>
<td>10925</td>
<td>USA</td>
<td>Jan 18, 1992 12:00:00 AM</td>
</tr>
<tr>
<td>Carter</td>
<td>Wan</td>
<td>12 Derek Way</td>
<td>El Paso</td>
<td>TX</td>
<td>77841</td>
<td>USA</td>
<td>Jan 25, 1993 12:00:00 AM</td>
</tr>
<tr>
<td>Casey</td>
<td>Keliya</td>
<td>12 Eastline Trail</td>
<td>Maple Plain</td>
<td>MN</td>
<td>51122</td>
<td>USA</td>
<td>Jan 15, 1991 12:00:00 AM</td>
</tr>
<tr>
<td>Coluccio</td>
<td>Xianlang</td>
<td>168 Twin Pines Crossing</td>
<td>Torrance</td>
<td>CA</td>
<td>95396</td>
<td>USA</td>
<td>Jun 30, 1993 12:00:00 AM</td>
</tr>
<tr>
<td>Chandra</td>
<td>Boris (A)</td>
<td>122 Bay Point</td>
<td>Corona</td>
<td>CA</td>
<td>90008</td>
<td>USA</td>
<td>May 22, 1993 12:00:00 AM</td>
</tr>
<tr>
<td>Cochran</td>
<td>Zoe</td>
<td>16 Summer Ridge Park</td>
<td>Rochester</td>
<td>NY</td>
<td>11753</td>
<td>USA</td>
<td>Oct 25, 1991 12:00:00 AM</td>
</tr>
<tr>
<td>Cochran</td>
<td>Lissette</td>
<td>16 Waxhing Crossing</td>
<td>Huntington Beach</td>
<td>CA</td>
<td>921391422</td>
<td>USA</td>
<td>Apr 25, 1993 12:00:00 AM</td>
</tr>
</tbody>
</table>

3. **Close** the New report results window.
4. **Save** the report as Student Data with UG Filter.
5. Select the table.
6. From the contextual toolbar, click the Filters icon and choose Edit Filters.
7. Click the Add button.
8. Choose Advanced and click OK.
9. From the Source tab, navigate to the Student Data > Student Class Data and double-click Academic Career to add it to the Detail filter expression.
10. The Detail Filter expression window opens.
11. Click the Functions tab to open it.
12. Expand the Operators folder.
13. Double-click the equal “=” sign to bring it into the expressions window.

You can also simply type =

14. Click back to the Source tab and make sure Academic Career is selected.
15. Click the Select Value icon in the top right of the window, next to the blue & white Validate button.

16. The Select value window opens.
17. Select UG (for Undergraduate). Click the Insert button.
18. You return to the Detail filter expression window.
   The expression should look like the below one.

   \[[\text{Fictitious Training Data}.\text{[Student Class Data}.\text{[Academic Career]}='UG'\]

19. Validate the expression by clicking the Validate button.
   If valid a No errors message appears in the Information window.
20. Click OK.

Spacing within the expression does not matter. Spacing between single quotes ‘ ’ is the exact string Cognos uses to search records in the Database.
The new filter will appear in the Filters window in the Detail Filters tab.

21. Click **OK** to accept the new filter expression.
22. Add **Academic Career** to the 3rd column of the report.
23. Sort the report on **Last Name** ascending.
24. Run the report.
25. Page down to the **Bottom**.
26. Notice that only **UG** data is showing.
   1. Close the **New report** results window.
   2. Save the report.
*Thinking Back*

If we wanted to see this same report (with the filter applied) but omit the Academic Career column from the report, what steps would we take?

Hint: Cut not Delete.

Sorting by Last Name ascending makes it easier to see that cutting the Academic Career column still returns the same data in both reports.

---

**Student Data with UG Filter**

<table>
<thead>
<tr>
<th>Last Name</th>
<th>First Name</th>
<th>Home Address Street</th>
<th>Home Address City</th>
<th>Home Address State</th>
<th>Home Address Postal Code</th>
<th>Home Address Country</th>
<th>Birth Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abere</td>
<td>Dick</td>
<td>48 8th Road</td>
<td>Reston</td>
<td>VA</td>
<td>22191</td>
<td>USA</td>
<td>Dec 9, 1993 12:00 AM</td>
</tr>
<tr>
<td>Abblasov</td>
<td>Poland</td>
<td>60 Almo Circle</td>
<td>New Castle</td>
<td>PA</td>
<td>19041</td>
<td>USA</td>
<td>Jan 9, 1951 12:00 AM</td>
</tr>
<tr>
<td>Abbott</td>
<td>Megan</td>
<td>70 Alpine Park</td>
<td>Lexington</td>
<td>KY</td>
<td>42671</td>
<td>USA</td>
<td>Jan 31, 1993 12:00 AM</td>
</tr>
<tr>
<td>Abbott</td>
<td>Molly</td>
<td>100 2nd Pass</td>
<td>North Las Vegas</td>
<td>NV</td>
<td>89148</td>
<td>USA</td>
<td>Mar 4, 1992 12:00 AM</td>
</tr>
<tr>
<td>Able</td>
<td>Geryue</td>
<td>70 Donner Junction</td>
<td>New York City</td>
<td>NY</td>
<td>11234</td>
<td>USA</td>
<td>Dec 27, 1992 12:00 AM</td>
</tr>
<tr>
<td>Abraham</td>
<td>Ava</td>
<td>30 Cottonwood Trail</td>
<td>Rockville</td>
<td>MD</td>
<td>20747</td>
<td>USA</td>
<td>Dec 26, 1993 12:00 AM</td>
</tr>
<tr>
<td>Abraham</td>
<td>Ava</td>
<td>0380 Pleasure Way</td>
<td>Boston</td>
<td>Massachusetts</td>
<td>02186</td>
<td>USA</td>
<td>Sep 18, 1993 12:00 AM</td>
</tr>
<tr>
<td>Abraham</td>
<td>Ava</td>
<td>90 Comanche Parkway</td>
<td>Los Angeles</td>
<td>CA</td>
<td>91754</td>
<td>USA</td>
<td>Sep 18, 1993 12:00 AM</td>
</tr>
<tr>
<td>Abraham</td>
<td>Ilene</td>
<td>10 Buena Vista Crossing</td>
<td>San Jose</td>
<td>NJ</td>
<td>95826</td>
<td>USA</td>
<td>Feb 14, 1992 12:00 AM</td>
</tr>
<tr>
<td>Abraham</td>
<td>Ilene</td>
<td>330 8th Junction</td>
<td>Trenton</td>
<td>NJ</td>
<td>00070</td>
<td>USA</td>
<td>Feb 14, 1992 12:00 AM</td>
</tr>
<tr>
<td>Abraham</td>
<td>Indian</td>
<td>40 Cardinal Junction</td>
<td>Belfast</td>
<td>Northern Ireland</td>
<td>591010DE</td>
<td>GER</td>
<td>Jun 22, 1993 12:00 AM</td>
</tr>
<tr>
<td>Abraham</td>
<td>Olivaun</td>
<td>60 Blue Bluff Drive</td>
<td>Atlanta</td>
<td>GA</td>
<td>36328</td>
<td>USA</td>
<td>Jun 21, 1993 12:00 AM</td>
</tr>
<tr>
<td>Abraham</td>
<td>Sebastian</td>
<td>8 Kedron Court</td>
<td>Brooklyn</td>
<td>NY</td>
<td>10573</td>
<td>USA</td>
<td>Jun 21, 1993 12:00 AM</td>
</tr>
<tr>
<td>Abraham</td>
<td>Sebastian</td>
<td>50 Brown Way</td>
<td>Denver</td>
<td>CO</td>
<td>80126</td>
<td>USA</td>
<td>Jun 21, 1993 12:00 AM</td>
</tr>
<tr>
<td>Abraham</td>
<td>Rebecia</td>
<td>2 Banker Hill</td>
<td>Jersey City</td>
<td>NJ</td>
<td>07017</td>
<td>USA</td>
<td>Jul 3, 1992 12:00 AM</td>
</tr>
<tr>
<td>Acevedo</td>
<td>Wreedin</td>
<td>70 Lakewood Plance</td>
<td>Kalamazoo</td>
<td>MI</td>
<td>49201</td>
<td>USA</td>
<td>Apr 7, 1992 12:00 AM</td>
</tr>
<tr>
<td>Achs</td>
<td>Gerdaline</td>
<td>80 Octor Point</td>
<td>Ipoh</td>
<td>Per#</td>
<td>47300</td>
<td>MAY</td>
<td>May 26, 1992 12:00 AM</td>
</tr>
<tr>
<td>Addley</td>
<td>Robert</td>
<td>600 Farrico Drive</td>
<td>Odessa</td>
<td>TX</td>
<td>75201</td>
<td>USA</td>
<td>Jan 5, 1992 12:00 AM</td>
</tr>
<tr>
<td>Adebisi</td>
<td>Brauerin</td>
<td>80 Ester Drive</td>
<td>Whistler</td>
<td>BC</td>
<td>V8W4H9</td>
<td>CAN</td>
<td>Nov 1, 1993 12:00 AM</td>
</tr>
<tr>
<td>Adhika</td>
<td>Ugachi</td>
<td>20 Forest Junction</td>
<td>Hyattsville</td>
<td>MD</td>
<td>20817</td>
<td>USA</td>
<td>Jun 25, 1993 12:00 AM</td>
</tr>
</tbody>
</table>
Filtering on a Single Item from the Data Items Tab

When creating reports that contain filters, it is common to show the column in the report that corresponds to the filtered subject. For instance, if you were filtering on Binoculars, generally, you would want to show the Product Type column to re-emphasize that the report is not limited to just one product type.

If a data item is deleted from the query, any filter referencing that data item will no longer work and the report will not run. Remember to cut the data item so that the filter continues to work.

1. Open the Pre-Filter report.
2. Check that you are in Edit mode.
3. Save the report as Canada.
4. Select the Home Address Country column (body, not header).
5. From the contextual toolbar, click the Filters icon and select Edit Filters.
6. Click the Add icon (bottom left off the Filters window).
7. Select Advanced. Click OK. The Detail Filter Expression window opens.
8. Select the Data Items tab next to the Source tab.

You will see a list of available components that currently exist in the report.
9. Double-click Home Address Country to add it to the Expression Definition window.
10. Type an = Sign

11. Click the Select Value icon.
12. In the Select Value window, scroll down and select CAN for Canada.
13. Click Insert.
14. In the Detail filter expression window, click the Validate button (blue and white check) to ensure there are no errors.
15. If the report is valid click OK to see the newly created filter in the Expression window.
   New filter: [Home Address Country] = 'CAN'
16. Click to OK accept the expression, and OK again to return to the report page.

17. Run the report or select the Page preview button (Page views drop down menu) to view the output.
   You will still see the Home Address Country column, only showing results for Canada.

18. Close the New report results window if you ran the report.
19. Save the report.
When a filter is created, there are three available Usage choices: Required, Optional, and Disabled.

The Filter default is to Required, so the new filter ([Home Address Country] = ‘CAN’) is active when the report is run. The Filter Usage option can be manually changed to Optional or Disabled.

Required means the filter must be used.

Choosing Optional means the report will run even if a filter value(s) has not been selected.

In a prompt with Optional activated, the report runs even if you do not make a value(s) selection.

Choosing Disabled allows the report to run as if there is no filter.

When there are report issues, disabling a filter(s) helps you to de-bug or trouble-shoot the report.

This feature allows you to turn the filter off temporarily.

In this exercise, we’ll adjust the Filter Usage to Disabled, in the Canada report.

1. Save the report as Canada disabled.
2. Select the Home Address Country column.
3. From the contextual toolbar, click the Filters icon and select Edit Filter.
4. Make sure the Detail Filters tab is selected.
5. Highlight the Canada filter.
6. Under the Usage section, choose Disabled.
7. Click OK.
8. Run the report or select the Page preview button to view the output.

Page down to view the Home Address Country. All countries now appear in the report output.
You will notice that all countries show when the filter is disabled.

9. Close the New report results window if you ran the report.
10. Save the report.
11. Close the report.

Clicking the Query tab (Q_List1) from the Report tab pull-down menu will reveal Data Items and Filters. You can manage these things from this area. See what happens when you double-click on either the Home Address Country data item, or the CAN Detail Filter. You may access the Detail filter expression window either way.
1. Navigate to My Content > Canada report.
2. Save the report as Gender.
3. Edit the report.
   Hint: Check that you are in Edit mode.
4. Check that you are on the report page.
   Hint: The breadcrumbs in the Report tab should look like:
5. From the Person Data query subject under Person Bio Data, add Gender as the third column of the report.
   Hint: Select Sources to navigate through the Training Data.
6. After adding Gender to the report you may see this message indicating the report has been updated and successfully validated.

7. Remove the existing Country (CAN) filter.
   Hint: Highlight the Home Address Country column body and select Edit Filters.
8. In the Filters window select the filter.
   Click the Delete button below the expression window.

9. Create a new filter on Gender, and set the filter to Female.
   Remember to choose Advanced in the New filter window.
   Hint: Gender = ‘F’.
   [Fictitious Training Data].[Person Data].[Gender] = ‘F’
10. **Hide** the Gender column.
   *Hint: Cut the Gender column so the filter still remains active. Do not **Delete** the column from the report. That will also delete the filter.*
   When the Gender column is highlighted Cut can be found in the More button drop-down menu.

11. **Save** the report.

12. **Run** the report, or view the report in Page preview.
   Notice that Female student data is now being returned.

13. **Close** the report.

<table>
<thead>
<tr>
<th>Last Name</th>
<th>First Name</th>
<th>Home Address Street</th>
<th>Home Address City</th>
<th>Home Address State</th>
<th>Home Address Postal Code</th>
<th>Home Address Country</th>
<th>Birth Date</th>
<th>Academic Career</th>
</tr>
</thead>
<tbody>
<tr>
<td>Barber</td>
<td>Chiaze</td>
<td>0037 Valley Edge Avenue</td>
<td>Elizabeth</td>
<td>NJ</td>
<td>00559</td>
<td>USA</td>
<td>Sep 18, 1983 12:00:00 AM</td>
<td>GR</td>
</tr>
<tr>
<td>Horner</td>
<td>Folasade</td>
<td>2949 Bellgrove Road</td>
<td>Newark</td>
<td>NJ</td>
<td>07302</td>
<td>USA</td>
<td>Aug 19, 1991 12:00:00 AM</td>
<td>GR</td>
</tr>
<tr>
<td>Anderson</td>
<td>Caroline</td>
<td>00399 Huxley Avenue</td>
<td>Singapore</td>
<td>SGP</td>
<td>510546</td>
<td>SGP</td>
<td>Aug 27, 1991 12:00:00 AM</td>
<td>UG</td>
</tr>
<tr>
<td>Whalen</td>
<td>Amanda</td>
<td>944 Vermont Avenue</td>
<td>Choperania</td>
<td>KEN</td>
<td>80109</td>
<td>KEN</td>
<td>Apr 27, 1991 12:00:00 AM</td>
<td>UG</td>
</tr>
<tr>
<td>Vorgara</td>
<td>Assunta</td>
<td>90317 Hoffman Drive</td>
<td>Hodo</td>
<td>CHN</td>
<td>513000</td>
<td>CHN</td>
<td>Apr 21, 1991 12:00:00 AM</td>
<td>UG</td>
</tr>
<tr>
<td>Price</td>
<td>Melisa</td>
<td>7 Waywood Trail</td>
<td>Phoenix</td>
<td>AZ</td>
<td>85710</td>
<td>USA</td>
<td>Mar 15, 1983 12:00:00 AM</td>
<td>UG</td>
</tr>
<tr>
<td>Edelman</td>
<td>Louise</td>
<td>216 Menomonie Lane</td>
<td>Fresno</td>
<td>CA</td>
<td>91706</td>
<td>USA</td>
<td>Jul 26, 1993 12:00:00 AM</td>
<td>UG</td>
</tr>
<tr>
<td>Comrie</td>
<td>Haafedca</td>
<td>199 Fallview Street</td>
<td>Palmdale</td>
<td>CA</td>
<td>94510</td>
<td>USA</td>
<td>Sep 26, 1992 12:00:00 AM</td>
<td>UG</td>
</tr>
<tr>
<td>Talbotten</td>
<td>Ronnie</td>
<td>874 Red Cloud Junction</td>
<td>New York City</td>
<td>NY</td>
<td>104566</td>
<td>USA</td>
<td>Dec 21, 1993 12:00:00 AM</td>
<td>UG</td>
</tr>
<tr>
<td>Sander</td>
<td>Victoria</td>
<td>736 Harbor Parkway</td>
<td>Roanoke</td>
<td>VA</td>
<td>20129</td>
<td>USA</td>
<td>May 10, 1992 12:00:00 AM</td>
<td>UG</td>
</tr>
<tr>
<td>Brady</td>
<td>Rachel</td>
<td>1 Anhalt Terrace</td>
<td>Springfield</td>
<td>MO</td>
<td>63066</td>
<td>USA</td>
<td>Jan 12, 1992 12:00:00 AM</td>
<td>GR</td>
</tr>
</tbody>
</table>
Filtering on Multiple Items – Using “In”
When using the equal sign “=”, the filter expression can only equal one item. If you want to create a multi-value filter, the “in” statement allows you to filter on multiple values.

In this exercise, we’ll apply a filter that returns only Canada and Egypt.

1. Open the Canada report for editing.
   **Hint:** Go to the Welcome page and select the Canada report. The Canada More button drop-down includes the Edit report selection.
2. Save the report as Multiple Countries.
3. Edit the Home Address Country filter.
   **Hint:** In the Filters window confirm that Usage is Required.
   Select the Pencil/Edit icon to open the Detail filter expression window.
4. Place your cursor at the end of the current filter statement and delete =’CAN’.
5. After [Home Address Country], type the word IN.
6. On the left, in the Available components window, go to Person Data.
7. Highlight Home Address Country. Click the Select Multiple Values icon.

8. Select and add both CAN and EGY.
9. Add the selections to the Selected values window on the right using the blue arrow in the middle.
10. Click Insert.
The new filter definition will appear in the Expression box:

[Home Address Country] in ('CAN', 'EGY')

12. **Validate** the report.
13. Click **OK** to return to the Filters window.
14. Click **OK** again to return to the report.
15. **Run** the report.
   Notice that the report output includes **Home Address Country** codes in Canada and Egypt.

16. **Close** the New report results window.
17. **Save** the report.

<table>
<thead>
<tr>
<th>Last Name</th>
<th>First Name</th>
<th>Home Address Street</th>
<th>Home Address City</th>
<th>Home Address State</th>
<th>Home Address Postal Code</th>
<th>Home Address Country</th>
<th>Birth Date</th>
<th>Academic Career</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arceneaux</td>
<td>Ganon</td>
<td>3 Badeau Avenue</td>
<td>Fort Erie</td>
<td>ON</td>
<td>M5G2G5</td>
<td>CAN</td>
<td>Sep 23, 1993 12:00:00 AM</td>
<td>GR</td>
</tr>
<tr>
<td>Fields</td>
<td>Chauncey</td>
<td>24119 Mifflin Road</td>
<td>Toronto</td>
<td>ON</td>
<td>K2X2L6</td>
<td>CAN</td>
<td>Jul 14, 1993 12:00:00 AM</td>
<td>UG</td>
</tr>
<tr>
<td>Kall</td>
<td>Almaz</td>
<td>4 Vermont Hill</td>
<td>Rayside-Balfour</td>
<td>ON</td>
<td>M2H1V4</td>
<td>CAN</td>
<td>Jul 14, 1993 12:00:00 AM</td>
<td>UG</td>
</tr>
<tr>
<td>Nancarrow</td>
<td>Max Thomas</td>
<td>6009 Valley Edge</td>
<td>Okanagan</td>
<td>BC</td>
<td>V9N6M2</td>
<td>CAN</td>
<td>Jan 5, 1992 12:00:00 AM</td>
<td>GR</td>
</tr>
<tr>
<td>Graham</td>
<td>Cassie</td>
<td>3 Badeau Avenue</td>
<td>Fort Erie</td>
<td>ON</td>
<td>M5G2G5</td>
<td>CAN</td>
<td>Jan 3, 1993 12:00:00 AM</td>
<td>GR</td>
</tr>
<tr>
<td>Nancarrow</td>
<td>Max Thomas</td>
<td>6009 Valley Edge</td>
<td>Okanagan</td>
<td>BC</td>
<td>V9N6M2</td>
<td>CAN</td>
<td>Jan 6, 1992 12:00:00 AM</td>
<td>UG</td>
</tr>
<tr>
<td>Kimmel</td>
<td>Rong Xuan</td>
<td>45211 Decalation</td>
<td>Alberta</td>
<td>AB</td>
<td>60000</td>
<td>EGY</td>
<td>Aug 4, 1993 12:00:00 AM</td>
<td>UG</td>
</tr>
<tr>
<td>Adesibi</td>
<td>Browett</td>
<td>80 Esker Drive</td>
<td>Whistler</td>
<td>BC</td>
<td>V9V4H5</td>
<td>CAN</td>
<td>Nov 1, 1993 12:00:00 AM</td>
<td>UG</td>
</tr>
<tr>
<td>Sangani</td>
<td>Arshneil</td>
<td>78999 Evergreen Driv</td>
<td>Stratford</td>
<td>ON</td>
<td>M3B3C1</td>
<td>CAN</td>
<td>Jan 15, 1992 12:00:00 AM</td>
<td>GR</td>
</tr>
</tbody>
</table>
Filtering on a Date Range – Using “Between”
The “between” expression allows the user to look for anything that occurred within a range of dates. We use start and end dates to filter the output data.

In this exercise, we will filter on a range of dates.

1. Open the Pre-Filter report for editing and Save it as Filter by Dates.
2. Sort by Birth Date ascending.
   Hint: Select the Birth Date column or header. In the contextual tool bar select Sort ascending.
3. Select the table. Click on the 3 orange dots in the top left of the header columns.
   Hint: next to Last Name header.
4. From the contextual toolbar, click the Filters icon and select Edit Filters.
5. Click the Add icon.
6. Select Advanced. Select OK.
7. From the Source tab, expand the Person Bio query subject to locate Birth Date and drag it or double-click on it to add it to the Expression Definition window.
8. Your cursor should be at the end of the expression definition, enter a single space.
9. Type the following: between 1991-01-02 and 1992-12-30.

The new filter expression is:
[Fictitious Training Data].[Person Data].[Birth Date] between 1991-01-02 and 1992-12-30

When using date-type fields in an expression, (i.e. Birth Date field), single quotes are not needed. Single quotes are needed for character-type fields, (like Name).

10. Click Validate to ensure there are no errors.
11. Click OK when ready to close the expression window.
12. Click OK to close the Filters window and return to the report.
13. Run the report.

Using the word “between” includes the beginning and the end date that is in the expression. January 2, 1991 and December 30, 1993 are included in the filter.

If we turn off the filter (disable it) we can see that there are a rows for January 1, 1991, and for Dec. 31, 1993 that do not appear when the filter is turned on.

15. Save the report.
Filtering Text – Using “Starts With”

Both, the “starts with” and “contains” operators are useful if you are not sure how to spell a name, or if you only know part of the name.

To filter using “starts with”:

1. Open the Pre-Filter report for editing and Save it as Filter Starts With.
2. Select the table.
3. From the contextual toolbar, click the Filters icon and select Edit Filters.
4. Click the Add icon.
5. Select Advanced.
6. From the Source tab, expand the Person Data query subject to locate Last Name and double-click to add it to the expression definition box.

Your cursor should be at the end of the expression definition.

7. Add a space.
8. Click the Functions tab and expand the Operators folder.
9. Locate and double-click the starts with operator. Or type in starts with.

Notice under the Information heading, it shows a tip how to write the starts with expression.

You have the ability to type expressions directly into the expression definition window, if you choose.

10. Position your cursor immediately after the starts with expression.

You may add a space or not. The below expression includes a space after starts with because I find it easier to read the expression with spaces. You may be content not to add spaces to your expression.

11. Open the Constants folder.
13. Position your cursor between the single quotes.
14. Type am.

Whatever appears in the string, (in this case: am), must exactly match the record stored in the database table.

14. Click Validate.
15. If there are no errors, click **OK** to return to the **Filters** window.
16. Click **OK** to return to the report page.
17. **Run** the report to see all the people whose last names start with the letters “am”.

**Answer:** *Whatever appears in the string must exactly match the record stored in the database. The report returns no data because the first letter of all last names in the database are upper case.*

We must change the filter so that names beginning with “Am” are found.

18. **Close** the Report Results window.
19. **Edit** the filter.
20. **Run** the report again.
21. **Save** the report.

The report will now show last names beginning with “Am”.

---

<table>
<thead>
<tr>
<th>Last Name</th>
<th>First Name</th>
<th>Home Address Street</th>
<th>Home Address City</th>
<th>Home Address State</th>
<th>Home Address Postal Code</th>
<th>Home Address Country</th>
<th>Birth Date</th>
<th>Academic Career</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ambeliotis</td>
<td>Rosanne</td>
<td>700 Westfield Road</td>
<td>London</td>
<td>England</td>
<td>59082</td>
<td>GBR</td>
<td>Aug 24, 1991 12:00:00 AM</td>
<td>GR</td>
</tr>
<tr>
<td>Ambeliotis</td>
<td>Roseanne</td>
<td>87 Quayside Vista</td>
<td>Canberra</td>
<td>ACT</td>
<td>2071</td>
<td>AUS</td>
<td>Aug 24, 1991 12:00:00 AM</td>
<td>GR</td>
</tr>
<tr>
<td>Ambeliotis</td>
<td>Cicolanza</td>
<td>00000 Nevada Pass</td>
<td>Santa Ana</td>
<td>CA</td>
<td>95035</td>
<td>USA</td>
<td>Nov 26, 1993 12:00:00 AM</td>
<td>UO</td>
</tr>
<tr>
<td>Anuma</td>
<td>Natalie</td>
<td>500171 Loomis Stree</td>
<td>Anaheim</td>
<td>CA</td>
<td>91607</td>
<td>USA</td>
<td>Apr 6, 1993 12:00:00 AM</td>
<td>UG</td>
</tr>
<tr>
<td>Ambeliotis</td>
<td>Rosanne</td>
<td>700 Westfield Road</td>
<td>London</td>
<td>England</td>
<td>59082</td>
<td>GBR</td>
<td>Aug 24, 1991 12:00:00 AM</td>
<td>UG</td>
</tr>
<tr>
<td>Ambeliotis</td>
<td>Roseanne</td>
<td>87 Quayside Vista</td>
<td>Canberra</td>
<td>ACT</td>
<td>2071</td>
<td>AUS</td>
<td>Aug 24, 1991 12:00:00 AM</td>
<td>UG</td>
</tr>
</tbody>
</table>
Filtering Text – Using “Contains”

In this exercise, we’ll filter a report to find all the last names which contain the letters “am”.

1. Using the current report, Save it as Filter with Contains.
2. Select the table.
3. From the contextual toolbar, click the Filters icon and select Edit Filters.
4. Select the filter in the window and click the Edit (pencil) icon.
5. Delete the “starts with ‘am’” part of the filter.
6. From the Functions tab, open the Operators folder and double-click contains.
7. Open the Constants folder and double-click string.
8. Position your cursor between the single quotes and type am.

Expression Definition:
[Fictitious Training Data][Person Data][Last Name] contains 'am'

9. Validate the expression.
10. Click OK (twice).
11. Run the report to see all the Last Names contain the letters ‘am’.
13. Save your report.

Filter With Contains

<table>
<thead>
<tr>
<th>Last Name</th>
<th>First Name</th>
<th>Home Address Street</th>
<th>Home Address City</th>
<th>Home Address State</th>
<th>Home Address Zip Code</th>
<th>Home Address Country</th>
<th>Birth Date</th>
<th>Academic Career</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gamaghebian</td>
<td>Tareeb</td>
<td>362 Cherokee Crossing</td>
<td>Appleton</td>
<td>WI</td>
<td>53992</td>
<td>USA</td>
<td>Aug 7, 1992 12:00 AM</td>
<td>GR</td>
</tr>
<tr>
<td>Chandraamouleeswaran</td>
<td>Lavocia</td>
<td>48864 Thier Pass</td>
<td>Springfield</td>
<td>Massachusetts</td>
<td>01532</td>
<td>USA</td>
<td>Aug 3, 1992 12:00 AM</td>
<td>GR</td>
</tr>
<tr>
<td>Samadder</td>
<td>Enesjat</td>
<td>7046 Portor Park</td>
<td>Virginia Beach</td>
<td>VA</td>
<td>22102</td>
<td>USA</td>
<td>Feb 12, 1993 12:00 AM</td>
<td>GR</td>
</tr>
<tr>
<td>Venkataramani</td>
<td>Frederick</td>
<td>902 Banker Hill Trail</td>
<td>Great Neck</td>
<td>NY</td>
<td>12309</td>
<td>USA</td>
<td>Mar 31, 1993 12:00 AM</td>
<td>GR</td>
</tr>
<tr>
<td>Termaker</td>
<td>Koriss</td>
<td>87 Quesiides Vista</td>
<td>Canberia</td>
<td>ACT</td>
<td>2671</td>
<td>AUS</td>
<td>Jan 21, 1993 12:00 AM</td>
<td>GR</td>
</tr>
<tr>
<td>Abraham</td>
<td>Illyun</td>
<td>339 8th Junction</td>
<td>Trenton</td>
<td>NJ</td>
<td>08070</td>
<td>USA</td>
<td>Feb 14, 1992 12:00 AM</td>
<td>UG</td>
</tr>
<tr>
<td>Lastminute</td>
<td>Vural</td>
<td>45 Praetiveley Park</td>
<td>Wriston Salam</td>
<td>NC</td>
<td>27403</td>
<td>USA</td>
<td>Jun 15, 1992 12:00 AM</td>
<td>UG</td>
</tr>
<tr>
<td>Subramanian</td>
<td>Whaven</td>
<td>85771 Gearon Pass</td>
<td>Athens</td>
<td>GA</td>
<td>30003</td>
<td>USA</td>
<td>Jun 36, 1992 12:00 AM</td>
<td>UG</td>
</tr>
</tbody>
</table>
Filtering Using “Like” and Wildcards
When trying to retrieve records that match a certain pattern, use the “like” operator. You can use the “like” operator in two different formats.

**With a Wildcard %:** Using the percentage sign (%) allows you to match any string, of any length, including strings with zero length.

**With an Underscore _:** Using an underscore (_) allows you to match on any single character.

In this exercise, we’ll apply a filter to return only records for people who live in a *Postal Code* which begins with “K” and then modify the filter to include a “K” somewhere within the *Postal Code*.

1. Using the previous report, Save it as **Multiple Postal Codes**.
2. Select the entire table. Select **Edit Filters**.
3. From the **Detail Filters** tab, single-click the filter **[Last Name] Contains ‘am’** to highlight it. Set the **Usage** to **Disabled**.
4. Click the **Add** icon.
5. Choose **Advanced**. Select **OK**.
6. In the **Expressions** window, add the **Home Address Postal Code** field from the **Person Data** query tab.
7. From the **Functions** tab, open the **Operators** folder and add the **like** Operator. Add a space.
8. Add **K%** after the **like** Operator between single quotes.

The Expression should read: [Fictitious Training Data].[Person Data].[Home Address Postal Code] like 'K%'

9. Validate the report. Select **OK** when the expression is valid. Select **OK** again to return to the report page.
10. Run the report.

![Multiple Postal Codes](image)

Starting the string with a capital letter (K) followed by the wildcard (%), requires that all **Postal Code** records returned will begin with a capital letter (K). The wildcard after the capital letter (K) indicates that any character (or number), can follow the capital letter (K).

All records returned will begin with a **capital K** in the **Postal Code** column, followed by either characters or numbers.

11. Close the **New report** results window.

---

Content in this document is based on fictitious data sets represented in CeDAR’s Training Package.
12. Let’s **Edit** your filter to include a “K” anywhere within the **Postal Code**.
13. Make sure the entire table is selected.
14. Select the **Edit Filters** button to open the **Filters** window.
15. Select and double-click the recent (postal code) filter to open the **Detail filter expression** window.
16. In the **Expressions** window, add a wildcard value (%) before the capital letter (K).

The Expression should read: *[Fictitious Training Data].[Person Data].[Home Address Postal Code] like ‘%K’*

---

17. **Validate** the expression. Click OK (twice) to close both filter windows. **Run** the report.

A 4th record appears. Editing the filter to contain a wildcard before the capital letter (K) returns **Postal Code** records that contain a capital K somewhere in the record.

18. **Close** the **New report** results window when done. **Save** the report.

---

**Creating a Custom Filter**

Not all filters need to go through the process we’ve been following to create them.
In some cases, we can filter on a particular field by creating a custom filter and selecting the value(s) we want.

1. Open the **Pre-Filter** report to edit.
2. **Save** the report as **Custom Filter**.
3. Select the **Home Address Country** column.
4. From the contextual toolbar, click the **Filters** pull-down menu, select **Create Custom Filter**.

A list of specific values for this particular column/field will appear.

5. Use the **Page down** arrow to find **USA**.
6. Check the **USA** box to add it to the **Keep these values** window on the right. Click **OK**.
7. You may see the below message regarding updating and validating the package. Click **OK**.

---

8. **Run** the report. Only USA Country values are returned.
9. **Close** the **New report** results window. **Save** your report.
Prompts

Parameters and Prompts

In Cognos Analytics, we use parameters and prompts to provide dynamic limits on a query.

When you create a filter, your filter criteria remains static. Prompts allow the user to change their criteria each time they run the report. The filter dynamically changes when the user responds to the prompt.

A parameter is a placeholder that requires a value to determine which data to report on. This placeholder is a parameterized filter. Prompts ask the user to provide a value (or values) for the corresponding parameter. Prompts can be placed on a Prompt Page.

Every prompt will have an associated parameterized filter in the query. It is not necessary for every prompt to have a prompt page created.

In this chapter, we will explore three ways of creating parameters:

- Modifying an existing filter to create a parameterized filter
- Creating a prompt page and then adding prompts onto the page
- Using the “Building a Page” button

Modifying an existing filter to create a parameterized filter:

If you create a parameter for an item on the report, when the report is run, the user will be prompted to specify a value. Once a value is selected, the report runs searching for data based upon the given value(s) in the prompt.

Creating a prompt page and adding prompts onto the page:

If you add a Prompt page to your report, the Prompt page appears when you run the report. A prompt page can contain multiple prompts, and the prompts can select for data items that are not on the report. Prompt properties can be changed to optional.

Prompt items can be added directly onto a report page. A prompt object can be selected and dragged from the Toolbox tab onto the report page next to a list, crosstab, or chart. When the report is run, the prompt page appears, enabling the user to narrow the output of the report.

If you add a prompt directly onto a report page, the user will need to set the prompt to automatically submit the selection, or add a “Finish” prompt button to the report so that the report will run using the new criteria.

Prompts are located in the Toolbox tab on the left navigation pane, under the Promoting section.

When the user selects items on a report and creates a prompt page, Cognos Analytics will choose an appropriate prompt type.

If the user adds a prompt item to a report or prompt page, the user can choose any type of prompt available in the toolbox.
The various prompt types and values are listed below:

<table>
<thead>
<tr>
<th>Prompt Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text Box Prompt</td>
<td>Inserts a text box prompt control where users type in values. Use this control when you know exactly what data item you want to enter, such as a name or chart string.</td>
</tr>
<tr>
<td>Value Prompt</td>
<td>Inserts a value prompt control where users select one or more values from a list. Use this control to show a list of possible values from which users can choose. The maximum number of items that can appear in a list is 5000.</td>
</tr>
<tr>
<td>Select &amp; Search Prompt</td>
<td>Inserts an advanced prompt control where users search for values. Use this control instead of a value prompt if the list of values is very long, which can slow down performance.</td>
</tr>
<tr>
<td>Date &amp; Time Prompt</td>
<td>Inserts a date and time prompt control where users select a date and time value. Use this control to filter a date/time or timestamp column. This control is useful for specifying ranges.</td>
</tr>
<tr>
<td>Date Prompt</td>
<td>Inserts a date prompt control where users select a date value. Use this control to filter a data column to retrieve records for a specific day, a set of days, or a range of days.</td>
</tr>
<tr>
<td>Time Prompt</td>
<td>Inserts a time prompt control where users select a time value. Use this control to restrict a report to a particular time or time range.</td>
</tr>
<tr>
<td>Interval Prompt</td>
<td>Inserts an advanced prompt control where users enter time duration values. Use this control to retrieve data that is related to the passage of time.</td>
</tr>
<tr>
<td>Tree Prompt</td>
<td>Inserts a data-driven prompt control that shows hierarchical information where users select one or more members.</td>
</tr>
<tr>
<td>Generated Prompt</td>
<td>Inserts a prompt control that acts as a placeholder. The report server will replace this control with an appropriate generated prompt control as if it was on a generated prompt page.</td>
</tr>
<tr>
<td>Prompt Button</td>
<td>Inserts a predefined button used in prompt pages. Its usage changes according to its type property, which can be set to “Cancel”, “Back”, “Next”, “Finish”, or “Re-prompt”.</td>
</tr>
</tbody>
</table>
Building a Parameter Filter

Let’s build a parameter filter.

1. Open the Gender report for editing.
2. Save the report as Gender Parameter.
3. View the report in Page preview mode.

4. Edit the filter.
   Hint: Select the table by clicking on the 3 orange dots in the top left corner of the table.
   Click the Filters drop-down menu, in the contextual toolbar, choose Edit Filters.
   Highlight the Gender filter.
   Click the Pencil/Edit button to open the Detail filter expression window.
5. In the Expression window, remove the single quotes on each side of the letter F and replace with question marks: ?F?
   Placing question marks around the value changes the filter into a parameter filter.
6. Validate the report.

A Prompt window will open to validate the new prompt.

7. Select a value. Click OK.

The Information window will show No errors.

8. Click OK to close the expression window.

9. Click OK to close the Filters window.

Let’s make the Gender field visible in our report to prove our upcoming results.

10. Select the Data tab from the Insertable objects window.

11. Select the Data Items tab.

12. Select the Gender query item and drag it to the third column of your report, next to first name. Release when you see the blinking one lane highway.

13. Save the report.

14. Run the report to HTML.

15. Select Male or Female in the prompt window.

16. Click OK.

17. Page down the report. Notice that only rows showing your Gender selection are in the report.

18. Close the New report results window.

19. Save the report.

20. Go to Prompt pages under the Report tab.
Since the prompt type is a parameter filter, we do not see any prompt pages in the **Preview** window.
Creating a Prompt Page

In this lesson, we will build a **Prompt page**.

1. Use the Pre Filter report (open to edit).
2. Save the report as **Prompt Page**.
3. From the Reports tab pull-down menu, select **Prompt pages**.
4. Click the + sign next to **Prompt pages** to add a new **Prompt page**.
   **Prompt page1** will appear in the Prompt Page pane.

5. Double-click **PromptPage1** to open the **Prompt page** window and build the prompt.
6. Drag a **Table** from the Toolbox Pinned section onto the **Prompt page** canvas.

7. The **Insert table** window opens.
8. Set the number of **columns** to “1” and the number of **rows** to “5”.
9. Click **OK**.

10. Drag and drop a **Text Item** into the first row of the table.
11. In the **Text Item** window that opens, type:
    **Choose a Country**
12. Click **OK** to accept the text.

13. In the **Toolbox**, open the **Prompting** section.
14. Drag and drop a **Value Prompt** into the third row of the table.

A **Prompt Wizard** window opens.

15. Name the new prompt: **Country Prompt**.
16. Click **Next >**.
17. Click the **More** Button (ellipse) next to the **Package Item** field.

18. Navigate to and select the query subject: **Home Address Country** in the **Person Data** query subject.
19. Click **OK** to add it to the **Value prompt**.

20. The Prompt Wizard – Value prompt window opens.
21. Leave the **Operator** field set to **=**.
22. Click **Next >**.

Note: if you wanted to make the Prompt optional this is where you would check that option.
23. Change the **Query Name** to:  
*Country Prompt Query.*

24. Click **Finish**.

A **Value Prompt** is now on the **Report page**.

25. Click once in the new **Prompt** box to select it.

26. Confirm that the **Value prompt** on the **Ancestor** row is selected.

27. In the **Properties** window, under the **General** section, sure **Required** should be set to **Yes**.

28. In the **Data** section click the **More (...)** button next to **Sorting**. The **Sorting – Country Prompt Query** window opens.

29. Move **Home Address Country** to the **Sort List** on the right. You can drag and drop it or double-click to add it.

   By default, the list sorts in ascending order alphabetically (blue arrow pointing up).

30. Click **OK**.
31. Double-click in the **Title/Text** area at the top of the report page to open the **Text** window.

32. Type in: **Country Report**.
33. Click **OK**.
34. Save the report.
35. Run the report.

36. Select **USA** from the **Prompt** drop-down list.
37. Click **Finish** at the bottom of the prompt page.

The report returns rows that only have **USA** as the **Home Address Country**.

Page down to confirm that only USA addresses are being returned in the output report.

38. Close the **New report results window**.
39. Save the report.
Identify and Explore the Query and Parameter Filter

When a **Prompt** is created on a **Prompt page**, an additional query is created by default. The **Prompt** also has a **Parameterized Filter**, which is created automatically.

*Each time you build a prompt page, a filter is created.*
*The report output data is narrowed down based upon the user’s prompt selection(s).*

In the **Prompt Page** report, explore the **Queries** tab.

1. From the left navigation, click the **Queries** tab.
2. Click the first **Query** (**Q_List1**) to select it and notice the data items in the **Data items** window on the right. Also notice the filter(s) listed under the **Detail Filters** section.

3. In the **Detail Filters** window, double-click the **Country Prompt** filter to open the **Expression Definition** window.
4. The question marks around **Country Prompt** indicate this is a prompt.

5. Now click the prompt we created (under **Q_List1**).
   Notice that in the **Data Items** window only the **Home Address Country** data item is listed.
   And the **Detail Filters** window is empty.

Content in this document is based on fictitious data sets represented in CeDAR’s Training Package.
Prompts – Selecting Multiple Items in the Same Prompt

Use the current Prompt Page report, we’ll modify the Prompt to multi-select values.

1. **Save** the report as **Multiple Prompts**.
2. To return to the Prompt page, click the Pages tab from the left navigation pane.
3. Click Prompt Page1.
4. Click once in the “Choose a Country” Prompt box.
5. Click the Properties button if the Properties window is not already open.
6. In the General section note that Multi-Select is set to No.

7. Change the Multi-Select to **Yes**.
   The Prompt user can now select more than one item, if desired.
8. Notice how the Prompt box shape changes in the window.
9. From the left navigation pane, click the Queries tab.
10. Under the Queries section, click Q-List1.

The Operator in the Parameterized filter needs to change so that the user can select more than one value.

12. Change the Operator from “=“ to “in”.
13. Click OK to return to the Filters window.

You may be prompted to choose a Prompt here in order to validate the report.
Choose any prompt.
However, whatever prompt you choose here will be held in memory when you run your report.

14. Click to the Pages tab from the left navigation pane and click Page1 to return to the Report page.
15. Run the report.
16. When the Prompt window appears, Select All. Then hold down the ctrl key and de-select USA.
17. Click Finish.
18. Click Page Down to see that USA is not in the list.
Prompt Button

1. Open the **Pre Filter** report for this next exercise.
2. **Save** as **Prompt Button**.
3. Right-click the **Last Name** field column header.
4. When the contextual toolbar comes up, click the **More** button.

---

5. Choose **Build Prompt Page** from the drop-down menu, half way down the list.

   Cognos Analytics will automatically build the prompt page, the prompt, and the filter.

6. **Run** the report.

   Select whatever you like when the **Prompt** window comes up.

   View your results.

7. **Close** the **New Report** results window.

8. **Save** the report.

9. **Close** the report.
1. Can you create a filter on something that is not visible in the report?

2. If a filter has been applied to a report you’re trying to run, but you would like to trouble-shoot and run it without the filter -- is there a way to run the report without it being applied?

3. What would the appropriate Operator be in an expression used to filter on more than one item in a column? Is there more than one you can use?

Answers:

1. Yes. A filter can be created by using fields from either the Data Items or Source Tab. If the field used in the Filter is from the Data Items tab, it is a field you have pulled into your report. You can CUT the field to make it disappear from your report but still filter on it.
   You can also filter on an item that you have NOT brought into your report using the Source Tab in the Filter Expression window.

2. To run a report and not have the filter applied, you can disable the particular filter in the Filters window.

3. The Operator “IN” is needed to filter on more than one item in a column.
   Example: [Home Address Country] in ('CAN', 'USA') -- think of “in the list of”

   *If you use the operator “=” it will only return one item from a column.
   *If you use the operator “BETWEEN” it will only return values between a range (as in a range of birthdays).
Formatting Reports

Building a Report

1. Start a new List report.
2. Create the following report from the Person Bio Query Subject with Interactivity mode turned OFF.

3. Save the report as Formatting.
4. Run the report.

Data formats
Text and data within the report can be formatted to make the report easier to read or to change to a more commonly used format in your department’s reporting structure.

In this exercise, we’ll be changing the format of the Birth Date column to mm/dd/yy.

1. Using the Formatting report we just created, Save the report as Data Formatting.
2. Click inside the column body of the Birth Date field (not the column header).
3. Click the Properties button and locate the Data section.
4. From the Data section, find Data Format and click the More button to the right.

The Data Format box will open.

5. Click the Format Type drop-down and choose Date.

6. Under the Properties section of this box, click Data Style.
A drop-down arrow will appear on the right.

7. Choose **Short** and click **OK**.
8. **Run** the report.

<table>
<thead>
<tr>
<th>Last Name</th>
<th>First Name</th>
<th>Home Address Country</th>
<th>Home Address City</th>
<th>Home Address State</th>
<th>Birth Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Campo</td>
<td>Rabeeah</td>
<td>USA</td>
<td>Sacramento</td>
<td>CA</td>
<td>7/16/91</td>
</tr>
<tr>
<td>Berry</td>
<td>Joan</td>
<td>USA</td>
<td>Milwaukee</td>
<td>WI</td>
<td>7/17/91</td>
</tr>
<tr>
<td>Bertrand</td>
<td>Hoju</td>
<td>USA</td>
<td>Staten Island</td>
<td>NY</td>
<td>12/4/91</td>
</tr>
<tr>
<td>Avery</td>
<td>Mary</td>
<td>USA</td>
<td>Long Beach</td>
<td>CA</td>
<td>5/11/93</td>
</tr>
<tr>
<td>Carr</td>
<td>Tim</td>
<td>USA</td>
<td>Lancaster</td>
<td>PA</td>
<td>1/17/92</td>
</tr>
</tbody>
</table>

9. **Close** the Report Results window.
10. **Save** the report.
Text Formats
In addition to the data format, the text format of the columns can be changed to make them stand out or to make them easier to read.

In this exercise, we’ll change the Country (Home Address Country) name to a bold font style.

1. Using the current (Data Formatting) report, click in the Home Address Country column body.
2. Right-click to reveal the On-Demand/contextual toolbar and choose Font.
3. Choose Bold from the Weight section of the Font Dialog Box.
4. **Run the report.**

<table>
<thead>
<tr>
<th>Last Name</th>
<th>First Name</th>
<th>Home Address Country</th>
<th>Home Address City</th>
<th>Home Address State</th>
<th>Birth Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Campo</td>
<td>Rabeeah</td>
<td>USA</td>
<td>Sacramento</td>
<td>CA</td>
<td>7/16/91</td>
</tr>
<tr>
<td>Berry</td>
<td>Joan</td>
<td>USA</td>
<td>Milwaukee</td>
<td>WI</td>
<td>7/17/91</td>
</tr>
<tr>
<td>Bertrand</td>
<td>Hoju</td>
<td>USA</td>
<td>Staten Island</td>
<td>NY</td>
<td>12/4/91</td>
</tr>
<tr>
<td>Avery</td>
<td>Mary</td>
<td>USA</td>
<td>Long Beach</td>
<td>CA</td>
<td>5/11/93</td>
</tr>
<tr>
<td>Carr</td>
<td>Tim</td>
<td>USA</td>
<td>Lancaster</td>
<td>PA</td>
<td>1/17/92</td>
</tr>
</tbody>
</table>

5. **Close the Report Results window.**
6. **Save the report as Formatting Text.**
Adding Headers and Footers

Cognos Analytics has several options when adding more detail to your report. Page headers and footers and/or list headers and footers can be added to provide additional information to the users about the contents of the report.

Page header and footer includes the following properties:

- Background color
- Background image
- Border
- Box type
- Conditional style
- Font
- Foreground color
- Horizontal alignment
- Padding size & overflow
- Spacing & breaking
- Text flow and justification
- Vertical alignment
- White Space

List headers appear at the beginning of a list for each grouped item and are good for presenting carry-forward group totals or group identifiers.

List footers appear at the end of the list for each grouped item and are good for presenting group totals.

Let’s add a list header to a report.

1. Use the Formatting Text report and save it as Headers.
2. Remove the Home Address Country, Home Address State, and Home Address City columns (by cutting them).
3. Add the Academic Program Description and Academic Career to the beginning of the report. The order in which you drag these fields in is important.
4. Group the Academic Career and Academic Program Description columns.
5. Right-click to reveal the On-Demand toolbar and click the More button.
6. From the menu, choose Headers and Footers and choose List Headers and Footers.
7. Place a check mark in the **Academic Program Descr (header)** box and click **OK**.
8. **Run** the report.

<table>
<thead>
<tr>
<th>Academic Program Descr</th>
<th>Academic Career</th>
<th>Last Name</th>
<th>First Name</th>
<th>Birth Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bachelor of Arts</td>
<td>UG</td>
<td>Abert</td>
<td>Molly</td>
<td>3/4/92</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Abraham</td>
<td>Ava</td>
<td>9/18/93</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Abraham</td>
<td>Iridian</td>
<td>6/22/93</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Abraham</td>
<td>Oliver</td>
<td>6/21/93</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Abraham</td>
<td>Sebastian</td>
<td>6/21/93</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Acevedo</td>
<td>Weedor</td>
<td>4/7/92</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ack</td>
<td>Gedaliahu</td>
<td>5/28/92</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Adderly</td>
<td>Robert</td>
<td>1/5/92</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Adebisi</td>
<td>Browerti</td>
<td>11/1/93</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Agrawal</td>
<td>Drazen</td>
<td>8/27/92</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Aguilera</td>
<td>Geirrion</td>
<td>8/23/93</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Aguirre</td>
<td>Jarrion</td>
<td>11/12/91</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ahluwalia</td>
<td>Rondalyn</td>
<td>2/14/93</td>
</tr>
</tbody>
</table>

9. **Close** the Report Results window.
10. **Click Save**.
Formatting the Title

Once you add a title, you can easily add formatting for emphasis. In some cases, you may be using a predefined template for your report. These titles can be formatted as well – just be advised that the title of the report will be the name you give the report when you save it.

If you created a blank report, you will have the ability to format/edit the title as well.

1. Using the current report, Save it as Title.
2. Click the Title and then click the Properties button. (The Properties window should read “Text Item”)

You can edit your report name in the Font & Text section of the report or you can right-click the report title to reveal the On-Demand toolbar and click the Font button.

3. Format the Font to Arial and the Font Size to 24pt.
4. Click Bold.

The Properties will reveal the confirmation.
5. Click **OK**.
6. **Run** the report.
7. **Save** the report.
Adding a New Page
Adding a new page enables you, as a report user, to add the page either as a title page before the body of the report, or as a secondary page that may serve as an additional reporting page, or as a summary.

Let’s add an Introduction Title Page.

1. Use the current report and Save it as Title Page.
2. From the Left Navigation, click the Pages tab.
3. With the Report Pages section selected, click the + button to add a new page.
4. Click and drag the newly created Page 2 above Page 1.

6. From the Properties window, scroll to the Miscellaneous section and locate the Name field.
7. Rename Page2 to “Title Page”.
8. Under the Report Pages heading, double-click the Title Page.

9. Click the + button in the middle to add a Table with 1 column and 3 rows.
10. Click OK.
11. Save the report.
Understanding the ‘Select Ancestor’ Button

The Ancestor button allows the user to select a group of related elements in a report, to change their properties individually or as a whole.

In this exercise, we’ll make the entire table one type of format.

1. Using the current report, Title Page, click into the 3rd row of the table on the Title Page.
2. Click Properties.

Notice the Ancestor is set to the Table Cell level.

3. Click the Select Ancestor button.

All ancestors above the Table Cell level will appear.

4. Select Table (different from Table Cell).

The entire table will now be selected.

5. From the Font & Text section in the Properties pane, make the Font Bold and set the Horizontal Alignment to Center.

6. Click the Toolbox tab.
7. Drag over a **Text item** and place it in the third row of the table.

8. Type “**Students by Academic Program**” in the text box and click **OK**.

   ![Text box with text](Image)

   The text is automatically bold and centered within the table.

9. Drag a second **Text Item** to the first row in the table.
10. Type “**Princeton University**”.
11. **Run the report**.

   ![Princeton University](Image)

   The title page displays first.

12. **Click Page Down** to see the next page of the report.

   ![Report](Image)

13. **Close** the Report Results window.
14. **Save** the report.
Drill Throughs
A Drill through is an operation which makes it possible to move from one report to another using the same analysis context. Drill throughs link two (or more) reports containing related information and appear in the source report as blue hyperlinks. Users click the hyperlink to select the value they want passed to the target report from the source report.

1. Navigate to Team Content > Training Data Reports > Cognos Analytics Class Reports > Drill Through – Parent Report.
2. Analyze the data.

We want to dig a little deeper. We’d like to be able to click on a particular student’s last name and see what their Academic Program Description is, which happens to be listed in another report we’ve written (hypothetically).

3. Select the Last Name Field Column (not header).
4. Right-click to reveal the On-Demand toolbar and click the More button.

The Drill-Through Definitions box opens up with the Target report tab active.

6. Click the Plus button to add a new drill through.
7. Click the **More** button to navigate to/select the **Drill Through – Child** report.
8. Click **OK**.

The Last Names will now show a blue link.

9. **Run** the report.
10. **Click the link of a Last Name** in the list to drill through to the next report.
Crosstab Reports

Crosstab reports are just like pivot tables. They are useful for comparative analysis because they summarize data and display the results in a two-dimensional grid.

Similar to List reports, Crosstab reports show data in columns and rows. However, the values at the intersection of rows and columns show summarized information rather than detailed information.

Crosstabs must include at least three query items: one on rows, one on columns, and one to serve as a measure or performance indicator defining what data represents.

In a crosstab report, data can be nested to compare information using more than one query item in a column or in a row.

<table>
<thead>
<tr>
<th>EmpID</th>
<th>Veterinary Medicine</th>
<th>Graduate School of Medical Sciences</th>
<th>Agriculture and Life Sciences</th>
<th>Government and Politics</th>
<th>Architecture</th>
<th>Language and Human Development</th>
<th>Engineering</th>
<th>Education</th>
</tr>
</thead>
<tbody>
<tr>
<td>ANT</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ARE</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>AUS</td>
<td>24</td>
<td>56</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>AUT</td>
<td>8</td>
<td>40</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BGD</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BGR</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BIH</td>
<td>24</td>
<td>88</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BRA</td>
<td>24</td>
<td>120</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BTN</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BWA</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CAN</td>
<td>240</td>
<td>88</td>
<td>88</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CHE</td>
<td></td>
<td></td>
<td></td>
<td>64</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CHN</td>
<td>48</td>
<td>312</td>
<td>736</td>
<td>264</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>COL</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Basic crosstab
Converting a List Report into a Crosstab

In this exercise we’re going to create a simple list report and convert it to a crosstab report.

1. Create a blank list report with the following fields from the Person Data Query Subject:
   - EmplID
   - Home Address Country

2. Drag the Academic Track field in from the Student Data Query Subject into the SECOND column (between Home Address Country and EmplID).


4. Run the report.

<table>
<thead>
<tr>
<th>Home Address Country</th>
<th>Academic Track</th>
<th>EmplID</th>
</tr>
</thead>
<tbody>
<tr>
<td>ANT</td>
<td>Agriculture and Life Sciences</td>
<td>39L4635J</td>
</tr>
<tr>
<td>ARE</td>
<td>Architecture</td>
<td>7X9X300H</td>
</tr>
<tr>
<td></td>
<td>Education</td>
<td>65004U18</td>
</tr>
<tr>
<td></td>
<td>Engineering</td>
<td>313H111D</td>
</tr>
<tr>
<td>AUS</td>
<td>Agriculture and Life Sciences</td>
<td>13C577C6</td>
</tr>
<tr>
<td></td>
<td>51016R2Q</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Education</td>
<td>5101S61M</td>
</tr>
<tr>
<td></td>
<td>Graduate School of Medical Sciences</td>
<td>6X6560X9</td>
</tr>
<tr>
<td></td>
<td>Language and Human Development</td>
<td>475K947A</td>
</tr>
<tr>
<td></td>
<td>6X6560X9</td>
<td></td>
</tr>
<tr>
<td></td>
<td>13C577C6</td>
<td></td>
</tr>
<tr>
<td>AUT</td>
<td>Agriculture and Life Sciences</td>
<td>51093R3B</td>
</tr>
<tr>
<td></td>
<td>Government and Politics</td>
<td>K0902422</td>
</tr>
</tbody>
</table>

5. Close the Report Results window.
6. Select the **EmplID** List Column Body.
7. In the **Properties** pane, scroll to the **Data Item** section.
8. Set the **Detail Aggregation** to **Count**.
9. Set the **Aggregate Summary** to **Total**.

> This step is crucial if we’re to convert this list report to a crosstab.

10. Click the **Academic Track** List Column Header.
11. Right-click to reveal the On-Demand toolbar.
12. Click the **More** button to reveal more menu options.
13. Select **Pivot List to Crosstab**.
14. The report layout has changed from a list report to a crosstab with **Academic Track** as the Column, **Home Address Country** as the Row, and **EmplID** as the measure.

15. **Sort Ascending** on **Home Address Country**.

```
<table>
<thead>
<tr>
<th>EmplID</th>
<th>#Academic Track#</th>
<th>#Academic Track#</th>
</tr>
</thead>
<tbody>
<tr>
<td>#Home Address Country#</td>
<td>#1234#</td>
<td>#1234#</td>
</tr>
<tr>
<td>#Home Address Country#</td>
<td>#1234#</td>
<td>#1234#</td>
</tr>
</tbody>
</table>
```

16. **Run** the report.

17. **Close** the Report Results window.

18. **Save** this report as **Crosstab**.
Crosstab Princeton Template
In this exercise, we’ll create a crosstab report using the Princeton template that counts how many students are either male or female for a given Academic Track.

1. Create a New report and select the Princeton Crosstab template.
2. Open the Training Package.
3. From the Student Data Query Subject, click and drag the Academic Track into the Rows area of the Crosstab.
4. From the Person Bio Query Subject, click and drag Gender into the Columns area of the Crosstab.
5. Drag EmplID from the Person Bio Query Subject to the Measures area of the Crosstab.
6. Click inside the Measures area.
7. From the Properties pane, under the Data Item section, change the Detail Aggregation to Count and the Aggregate Summary to Total.
8. Run the report.

<table>
<thead>
<tr>
<th>EmplID</th>
<th>M</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>Veterinary Medicine</td>
<td>880</td>
<td>544</td>
</tr>
<tr>
<td>Language and Human Dev</td>
<td>10336</td>
<td>9093</td>
</tr>
<tr>
<td>Education</td>
<td>4434</td>
<td>2584</td>
</tr>
<tr>
<td>Agriculture and Life Sc</td>
<td>11028</td>
<td>9640</td>
</tr>
<tr>
<td>Graduate School of M Sc</td>
<td>7220</td>
<td>5824</td>
</tr>
<tr>
<td>Engineering</td>
<td>4584</td>
<td>3112</td>
</tr>
<tr>
<td>Government and Politics</td>
<td>6752</td>
<td>4528</td>
</tr>
<tr>
<td>Architecture</td>
<td>4672</td>
<td>2782</td>
</tr>
</tbody>
</table>

10. Save the report as Gender Count Crosstab.
Nested Crosstabs
In this exercise, we’ll nest data in a crosstab report to compare information using more than one query item in a column or row.

1. **Open** the Crosstab report.
2. **Save** it as **Nested Crosstab**.

In this report, the **Home Address Country** data item represents the rows and **Academic Track** data item represents the columns.

3. Right-click the header row to reveal the On-Demand toolbar and select the **Swap Rows and Columns** icon.

![Swap Rows and Columns](image)

At this time, after making the swap, the **Academic Track** data item represents the rows and the **Home Address Country** data item represents the columns.

4. From the **Source** tab, click and drag the **Academic Department** data item into the report beside **Academic Track**.

![Academic Department](image)

The columns are now nested.
5. **Run** the report and scroll to see all the countries.

6. **Close** the Report Results window.

7. **Save** the report.

<table>
<thead>
<tr>
<th>EmplID</th>
<th>ANT</th>
<th>ARE</th>
<th>AUS</th>
<th>AUT</th>
<th>BGD</th>
<th>BGR</th>
<th>BIH</th>
<th>BRA</th>
<th>BTN</th>
<th>BWA</th>
<th>CAN</th>
<th>CHE</th>
<th>CHN</th>
<th>COL</th>
<th>DEU</th>
<th>DOM</th>
<th>ECU</th>
<th>EGY</th>
<th>ESP</th>
</tr>
</thead>
<tbody>
<tr>
<td>Veterinary Medicine</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Biomedical Sciences &amp; Research</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Agriculture and Life Sciences</td>
<td>32</td>
<td>8</td>
<td>64</td>
<td>32</td>
<td>32</td>
<td>192</td>
<td>64</td>
<td>32</td>
<td>32</td>
<td>192</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Clinical Research</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Microbiology and Immunology</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Animal Science</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Biology</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Nutritional Sciences</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Livestock and Farming Husbandry</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Crosstab with Totals
Let’s add totals to the current report.

1. Use the **Nested Crosstab** report.
2. Select the **Measure** area of the report.
3. Right-click to reveal the On-Demand toolbar and click the **Summarize** icon.

![Nested Crosstab Report](image)

4. **Select Total.**

![Crosstab with Totals](image)

Totals are now added to the report.

5. **Run** the report.

![Crosstab with Totals](image)

6. **Close** the Report Results window.
7. **Save** the report as **Crosstab with Totals**.

Content in this document is based on fictitious data sets represented in CeDAR’s Training Package.
Creating a Mail Merge/Letter

1. Create a **New** report with a blank template.
2. From the report type options, choose **Table**.
3. Format the table with 1 column and 10 rows.
4. Click **OK**.

You’ll notice each row is populated with the **Add** button which allows you to bring data into your table.
5. From the Left Navigation, click the Queries tab.
6. Add a query to your report by clicking the Add Query button (+).

7. From the Left Navigation, click the Pages tab and select Page1.
8. Click Properties.
9. From the Properties pane, under the Data section, click the drop-down arrow next to Queries and select Query1.

10. Save the report as Mail Merge Letter.
11. From the Left Navigation, click the Toolbox tab.
12. Expand the Textual section.
13. Click and drag **Date** over to the first row in the report.

14. Right-click to reveal the On-demand toolbar and click the drop-down beside the **Alignment** button.

15. Select **Right** to change the **Date** field from the Default alignment to **Right**-alignment.

16. From the **Toolbox** tab, drag a **Text item** into the second row.

17. In the text box, insert at least 20 spaces.

This will create an open space within the report.

18. Click **OK**.
19. From the Data Pane tab, navigate to the Training Package.
20. From the Person Bio Data Query Subject, expand the Person Data folder.
21. Drag First Name and Last Name into Row 3 of the table.

22. To create a salutation on our letter, double-click the First Name field to open the Data Item Expression window.
23. Place your cursor at the beginning of the filter expression window and type ‘Dear ’ (**making sure there’s a space inserted before the single closing quote).
24. To insert a space between the word “Dear” and <First Name>, click the Functions tab and scroll to find ||. Double-click || to bring it into the expression.
25. Place your cursor at the end of the expression and add an additional || followed by a single quote, a space, and another single quote.

**Your expression should look like this: ‘Dear ’ || [Fictitious Training Data].[Person Data].[First Name] || ’**

26. Click the Validate button to ensure there are no errors.
27. Click OK.
28. Double-click the Last Name field to open the Data item expression window.
29. Add || '"', ' to the Last Name Expression Definition window to add a comma after Last Name in our letter.

30. Click OK.
31. Run the Report to PDF.

32. Close the Report Results window.
33. Save the report.

Now, let’s create a page for each unique person. To do this, Query1 needs to be modified with a unique identifier. We will create separate pages in a report that is being distributed to many people.

To identify a unique person, we can use EmplID.

34. From the Left Navigation, select the Queries tab.
35. Select Query1 to reveal the Data Items pane.

Notice that among the listed Data Items, there is not a unique identifier.
36. From the Left Navigation, select the Data tab.
37. From the Person Bio Query Subject, double-click the EmplID (or drag it over) so that it is listed as a Data Item in the Data Items pane.

38. From the Left Navigation, select the Pages tab and select the Report Pages folder.

The Report Pages pane will be visible on the right.

39. From the Left Navigation, click the Toolbox tab.

41. Drag the Page Set so that it appears above Page1.
42. Now, drag **Page1** into the **Detail Pages** folder so that it is nested.

43. From the **Report Pages** pane, click on the **Page set1** and then click the **Properties** button to view the Properties of the Page Set.

44. In the **Data** section, click the drop-down next to **Query** and select **Query1**.
45. Click into Grouping & Sorting to reveal the More button and click it.

The Grouping & Sorting window for Query 1 will appear.

46. Drag the Data Item “EmplID” into the Overall group.

A folder for Sort list will appear.

47. Click OK.
48. From the Left Navigation, click the Pages tab and select Page 1.
49. Select and then right-click in the second row (where we added a blank row) to reveal the On-Demand Toolbar.
50. Click the More button to reveal the contextual menu and select Copy.

51. Paste the copied row into Row 4 by using the On-Demand toolbar (or keyboard shortcut: CTRL V).
52. From the Left Navigation, click the Toolbox tab and insert a Text Item into Row 5.
53. In the Text window, type the following: Welcome to the University Community. We hope you will join us for opening ceremonies on Sept. 3 at 11am in the University Assembly Hall.
54. Click OK.
55. From the Application Toolbar, click the Page Views button and set the view to Page Preview.

This allows us to see, at a glance, a preview of our report without running it.
56. Insert another blank row into Row 6 (copy from rows above or drag a Text Item in from the Toolbox and add 20+ spaces into the Text window.)

57. Drag an additional Text Item into Row 7 and type the following into the Text window: **Please review the below information and contact your department only if it is not correct. We look forward to seeing you on Sept. 3.**

58. From the Toolbox tab, drag over a List Item into Row 8.

59. When the Object and Query Name window opens, select **Query1** from the pull-down menu.

60. Click **OK**.
61. From the Left Navigation, select the Data tab and expand the **Student Class Data** Query Subject.

62. Using the CTRL key, (CTRL + Click)
   - Academic Program
   - Academic Program Desct
   - Academic Track
   - Academic Dept

63. Drag these fields into the List.

64. **Run** the Report.

65. **Close** the Report Results window.

66. **Save** the report.

Let’s add some space (a row) between the last paragraph and the List. To do this:

67. **Select the entire List.**

68. Right-click to reveal the On-Demand Toolbar and click the **More** button.

69. Select **Insert > Rows above**
70. Enter **1 Row** and click **OK**.
71. Copy and Paste one of the **blank rows** above into the new row.
72. **Save** the report.
73. **Select the entire List**
74. **Drag the List** by the 3 Dots on the top left corner and move it **to the bottom of the report** to make room for the closing of the report.
75. **Insert an additional row** above the List.

76. **Add a Text Item** to each of the remaining rows.
   - For the first remaining row, in the Text window, enter: **Sincerely,**
   - For the second remaining row, in the Text window, enter: **Office of Student Affairs**

77. **Add one more blank row** after the closing and before the List.
78. Run the report to PDF.

79. Scroll down to see how each student has their own letter.

80. Close the Report Results window.

81. Save the report.
Thank you for attending!

Additional documentation is being developed. As an addendum to this guide, we will be including a chapter on Dashboards as well as working with uploaded spreadsheets.

Questions?

Please feel free to email me directly, leaht@princeton.edu or cedar@princeton.edu.